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Zetadocs PDF overview 

Zetadocs offers an easy and reliable way of creating personalized Acrobat® compatible PDF documents in any
Windows® application. 

Documents can be viewed on screen and enhanced by adding stationery and by adding, removing or
re-ordering pages. Other documents such as price lists and brochures can be combined for sending as single
PDF files to one or more recipients using Microsoft® Outlook.®

How Zetadocs can be deployed in a network
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Getting started 

Zetadocs PDF allows you to create a PDF document that you can send using Microsoft Outlook from almost any
Windows application.  This tutorial will introduce you to the basic features of Zetadocs PDF.  Using some of the
documents created on installation, you will:

a) Print a document from Word.
b) Apply stationery and an attachment.
c) Send the document as a PDF to a recipient in your Outlook address book.

Please follow the instructions below:

1) Open any document in Microsoft Word.  On installation, Zetadocs creates shortcut buttons within Microsoft
Office applications to make it simpler to use.  If you are using Office 2007, click the Office Button and
select “Send”. Select “Email using Zetadocs PDF” as in the screen below.  Alternatively, you can select Print
and choose the Zetadocs printer. For office 2003 users, click "File | Print" and select the Zetadocs PDF
printer.  Zetadocs PDF will run and you will see your document in the reading pane.
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NB: For Office 2003 users, a toolbar button is installed in your standard toolbar.  Click on the "Zetadocs
PDF" button.  

2) On the Zetadocs PDF toolbar, click "Accessories".  The Accessories window opens.  

3) Select the "Zetadocs PDF" folder and "Stationery" from the "Type" drop down list.  Highlight the stationery
entitled "WM Stationery". A thumbnail preview appears.  Click the "Apply" button or drag the stationery to
your document in the Document Explorer window.  The stationery is merged with your document.

4) From the Accessories window, select "Attachment" from the "Type" drop down list, in the Zetadocs PDF
folder.  Highlight the attachment entitled "WM attachment".  Click the "Apply" button or drag the
attachment to your document in the Document Explorer window.  The attachment will be added to your
document.  The image in the thumbnail view is also updated, showing all pages of your document.  You can
click on any of these pages to view them in the reading pane.
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5) To address the document, select the document name which appears at the "root" of the document tree in
the document explorer window.  The display in the reading pane changes to an email form, as in the screen
shot below.  Write and address your email using the form as you would with Outlook.  
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6) On the Zetadocs PDF toolbar, click "Send".  An Outlook email form will pop up that contains your message
and your PDF attachment.

The tutorial is complete.  
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What Zetadocs can do for you 

Zetadocs makes your life easier by automating your document processes

· Reduce your processes to one or two steps by setting up templates to combine standard items such as price

lists and brochures into your documents automatically.

· Set up folders for departments so team members can share Zetadocs documents.

· Set Zetadocs to copy your PDF documents to managers or public folders automatically as they are sent.

· Store and maintain your corporate stationery such as letterhead centrally, so any Zetadocs user can then

overlay it onto their documents.

· Store and maintain your standard documents such as price lists and brochures centrally.

· Use Word Mail merge with Zetadocs' embedded commands to automate the emailing of mail merges: each

recipient receives a personalized email with a personalized PDF attachment.

· Use Excel lookup functions to instruct Zetadocs to include the appropriate PDF documents from a shared

library in emails automatically.

· Integrates easily with quotation and booking systems, databases, CRM, ERP and accounts software to save

time, ensure consistency and improve the presentation of documents.

Related Topics
The benefits of using PDF documents
The key benefits of using Zetadocs PDF
The key features of Zetadocs PDF
Benefits of Zetadocs PDF
Features of Zetadocs PDF
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The Zetadocs client 

To familiarize you with the general screen set up of Zetadocs, the following quick descriptions introduce the
main parts of the program to help you get started quickly and easily. 

Document Explorer Window
The document Explorer Window shows you all the items that have been sent to the Zetadocs PDF application
for printing. 
This allows you see what items are waiting to be sent, and what components are included in each document.
This view allows you to manage the order of sections within your document and delete unwanted sections.

Thumbnail view
The thumbnail view allows you to see an overview of your spooled document. 

This allows you to:

· Navigate to particular pages within a spooled document.
· Change the page order within a document section.
· Change the order of document sections. 
· Delete pages. 
· Apply stationery to individual pages. 

Accessories
The accessories option allows you to customize your documents before sending them. There are four different
types of accessory you can add to your document. in addition using this pane, you can access your sent PDF
archive if this has been configured by your administrator:

Related Topics:
What is a  document?
Add stationery to my document
Add an attachment to a document
Use a document template
Re-submit a sent PDF
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The key benefits of Zetadocs PDF

Automated document production and delivery
Zetadocs is designed to save time by automating document processes for teams and departments right across the 
organization:

· Automate production and delivery of PDF documents for specific tasks like sales quotations, account statements, customer

information 
packs and management reports and send them automatically.

· Combine any number of Windows documents to create a single, great looking PDF.

· Multiple users can have access to individual Zetadocs documents stored centrally on the network: 

changes made to standard documents such as corporate letterhead need only be made once.

· Apply rules to copy your documents to colleagues, management or public folders automatically.

Profit from productivity improvements 
Zetadocs can replace arduous paper processes, so everyday tasks can be completed faster:

· Store and update standard or commonly used documents such as price lists and brochures centrally 

in Zetadocs for fast retrieval.

· Deliver documents instantly, to single or multiple recipients, and improve your customer service. 

· Simply print from any Windows application to create your PDF, then drag and drop other documents 

into it to build a single PDF that you can preview as you go.

Smarter documents for better business
Company branding like letterhead and logos can be added to any document created with Zetadocs, helping you
make a positive impression on your customers.

· Create great looking PDF documents effortlessly on screen, without the inconvenience or wastage of 

paper.

· Ensure employees' compliance with best practice by automatically adding standard documents like 

Terms and Conditions to sales quotations and purchase orders.

· Apply security automatically to all outbound documents, maintaining confidentiality.

Save time searching for attachments by merging your documents to create a single, convenient PDF file, tailored for 
each recipient

Easy to use and manage 
Zetadocs is intuitive, so network users can get quickly up to speed, and can be installed, configured and deployed 
quickly and easily.

· The Zetadocs Outlook addin makes it simple for users to create, merge and send PDF documents  directly from within

Outlook.

· Deploy from a single, central location using Windows Group Policy: no need to install or configure at individual desktops.

· Automatic update service gives access to latest version upgrades and patches.

Related Topics:
What Zetadocs can do for you
Features of Zetadocs PDF
Benefits of Zetadocs PDF
Key features of Zetadocs PDF
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The key features of Zetadocs PDF 

PDF creation
· Create and send Acrobat compatible PDF documents from any application that prints.

· Drag and drop files to Zetadocs PDF printer to convert single or multiple documents.

· Microsoft Office® addin simplifies sending from Office applications, including Word, Excel, Powerpoint and Outlook.

· Send PDF documents directly to email recipients.

· Save PDF documents to disk for publishing to intranets or web sites.

· Maintain document integrity by specifying PDF security features such as allow printing, content extraction and password

protection.

· Create searchable PDFs so that information can be retrieved quickly and simply.

· Password protect PDFs using 40-bit and 128-bit encryption to prevent unauthorized viewing.

· Merge multiple existing PDFs into a single document without losing properties such as typefaces.

· Compact PDF file size means documents created using Zetadocs are quick to send and download.

· Automatically apply unique page numbers (Bates Stamps) to outbound documents.

Zetadocs PDF interface
· Combine documents from multiple sources such as Microsoft Word and Excel into a single PDF.

· Apply stationery like business letterhead to enhance the look of your documents.

· Build PDF documents using a WYSIWYG image of what your recipient will see.

· Quickly convert documents to a single PDF and send them using Microsoft Outlook.

· Document Explorer shows lists of documents printed to Zetadocs and that are waiting to be sent.

· Resend option allows documents to be resent easily.

· Reading pane allows you to view your document in detail, at different resolutions.

· Thumbnail view helps you navigate around your document and modify page order.

· Drag and drop pre-saved stationery or attachments from the Accessories Window to build your document.

· Filter Accessories by type to allow fast access to specific document types.

· Preview window allows you to preview thumbnails of stationery and attachments before applying them to your document.

· Remove stationery and delete page to remove unwanted changes.

· Outlook Address Book integration enabling quick retrieval of lists for message addressing.

· Assistant Pane provides context sensitive help on how to use Zetadocs.

Document automation
· Print and send documents as PDF by email or fax (optional) with a couple of mouse clicks, saving time on document

production.

· Combine with Microsoft Word's Mail Merge or other report writers to send PDF documents singly or in batches.

· Personalize PDF documents for each recipient, sending specific, tailored information to each individual as required.

· Specify which stationery, attachment or template to use under program control.

· Specify email message body text, subject line and recipients in "To", "Cc" and Bcc" fields.

· Microsoft Office add-in allows users to add automation commands automatically.

· "Copy automation" command enables error-free set up of document automation commands.

Document template properties
· Templates allow properties of document types to be specified, such as always add conditions of sale and company

stationery for quotations.

· Document template creation wizard makes it simple to create and share document templates, saving time and ensuring
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consistent corporate image.

· Electronic stationery can be applied to document templates and modified easily.

· Single or multiple attachments can be saved in the system for quick access and re-use, saving time.

· Define email message body and recipients: a standard email covering message can be applied in a document template,

saving time.

Microsoft Office integration
· Seamless Microsoft Office Outlook integration allows users to create, combine and send multiple documents as single PDF

files directly from within Microsoft Outlook.

· Office button, Ribbon (Office 2007 only) and Toolbar (Office 2003 only) addins for Microsoft Word, Excel and Powerpoint

enables mouse click document creation and sending.

· Preview documents before sending, if desired.

· Full sent message audit trail using Microsoft Outlook/Microsoft Exchange Server means sent items can be quickly retrieved

and resent.

· Integration with Microsoft Outlook address books allows for direct lookup and retrieval of addressee information.

Multi-user features
· Standard documents such as stationery and attachments can be stored on the system for fast access

by network users.

· Shared stationery, attachments and document templates can be managed centrally by Network

Administrators or Business Managers to ensure documents comply with best practice and consistent
corporate image.

· Personal documents are protected using file system security.

Related Topics:
What Zetadocs can do for you
Features of Zetadocs PDF
Benefits of Zetadocs PDF
Key benefits of Zetadocs PDF
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Technical specifications

Operating systems supported: 

• Windows® Vista Business, Ultimate and Enterprise (32-bit and 64-bit)

• Windows XP Professional (32-bit)

• Windows Server® 2008 Standard Edition (32-bit and 64-bit)

• Windows Server 2008 with Windows Terminal Services

• Windows Server 2008 with Citrix Presentation Server 

• Windows Server® 2003 Standard Edition (32-bit and 64-bit)

• Windows Server 2003 with Terminal Services

• Windows Server 2003 with Citrix Presentation Server® 4 and 4.5

• Requires Microsoft.NET Framework® version 2.0

• Integrates with Microsoft Office Outlook® 2003 and 2007 

• Integrates with Lotus® Notes® V6.5 and above

• Integrates with SMTP email systems

• Integrates with Microsoft Word versions XP, 2003 and 2007

• Active Directory® integration for rapid and easy deployment to all network users

PDF capabilities: 

• Create PDF files which are readable using Adobe® Reader® software version 5 and later 

• Supports PDF attachments created in PDF 1.2, 1.3, 1.4 and 1.5 standards 

• Specify PDF security options such as allow printing, content extraction and password protection 

• Password protection using 40-bit and 128-bit encryption
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The benefits of using PDF documents 

Preservation of document format     
PDF documents can preserve the look and feel of documents with typefaces embedded within the document
and viewed on any computer regardless of whether those typefaces are already available on that PC.
 

Security          
Documents created using Zetadocs PDF can be specified as read only, restricted print  or encrypted (ie only
opened with a password). 

Platform independence           
PDF electronic documents can be read on Windows, Mac, Palm, PocketPC, Symbian and Unix platforms. 
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How to print to the Zetadocs PDF printer

Printing to the Zetadocs PDF printer from any Windows based application is just as easy as printing to your
normal printer.

Step 1: When your document is ready to print, select the Print option from the file menu.

Step 2: Choose the Zetadocs PDF printer.

Step 3: Press the OK button.

The document will now be sent to the Zetadocs PDF printer. 
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How to use the thumbnail view

The thumbnail view provides you with a small image of each page that is present in a spooled document. 

There are a number of tasks you can perform using the thumbnail view:

How to use the thumbnail view to preview a specific page 

Step 1: Select the spooled document you wish to work on from the document explorer pane on the left hand
side of your application window. This can be done by left clicking your mouse over the title. 

This will automatically display a thumbnail view of all the pages contained within that spooled document. 

Step 2: By finding the image of the page that you wish to preview and left clicking your mouse over the
image, you can navigate to a specific page.

How to use the thumbnail view to manipulate the page order of a document

Step 1:  Select the spooled document you wish to work on from the document explorer pane on the left hand
side of your application window. This can be done by left clicking your mouse over the title.

Step 2:  Select the page which you wish to move.

Step 3:  Right click your mouse to display a list of options.

Step 4:  Select move page up to swap the selected page's position with the page above or move page down to
swap the selected page's position with the page below. 

How to use the thumbnail view to delete a page 
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Step 1:  Select the spooled document you wish to work on from the document explorer pane on the left hand
side of your application window. This can be done by left clicking your mouse over the title. 

Step 2:  Select the page which you wish to delete.

Step 3:  Right click your mouse to display a list of options.

Step 4:  Select the delete page option to remove this page from the spooled document . 

Related Topics:
What is the thumbnail view?
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How to use an address book  

You can access your Microsoft Outlook address book directly from Zetadocs. This allows you to address your
message from within Zetadocs.

To do this follow the steps below:

Step 1: Select the root of your document in the document explorer window to display the messaging option
screen.

Step 2: Click on the To... option. 

Step 3:  This will open your Outlook address book, allowing you to find your contact and add them to your
email.

Related Topics
What is the address book?
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How to send a document via email  

When your document is ready to be sent via email, select the Send option on the top left hand of your
program window.  This will convert your document in to a PDF file, and automatically attach this PDF to an
email message ready to be sent.

Should you have multiple emails ready to be sent within your document explorer window, you can select
the Send all option to send all the documents at the same time.  This is especially useful if you are sending
out a large batch of documents.
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How to send a document via fax

If you have the Zetafax client installed on your computer, it is possible to send out documents created within
the Zetadocs client as fax attachments.

To do this:

Step 1: On the addressing dialog you will notice there is a fax addressing line. To add your fax address you
can either:

Step 2: Add your fax address by hand using the following format:
recipient_name@recipient_company@fax_number - for example: Jim Jones@Jones Construction@555 456
6666
       
Or Add your fax address using the fax addressing wizard

Step 3: Enter the name of the person you wish to send a fax to, their company name and their fax number
into the boxes provided and click Add to list.

Step 4: Select OK when you are ready to return to your message.

Step 5: Select the Fax Options button to choose your coversheet, letterhead and sending options. 
Note: Any fax options will only be applied to messages sent to fax recipients.  

Step 6: Include any text that you wish to be displayed on your coversheet in the message body.

Step 7: You can view the appearance of your fax at any time by selecting the Fax Preview button on the
Zetadocs toolbar.

Step 8: When you are happy with your fax message, click Send to send your message.
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How to address a message 

Just like addressing a normal email, documents sent to Zetadocs can be sent either by manually typing in their
contact details or by accessing an address book and selecting the person's details that you wish to send the
message to. In addition, you can send your message to multiple recipients and send a Carbon Copies (Cc) or a
Blind Carbon Copies (Bcc) to your contacts.

To address a message follow the steps below:  

Step 1:  In the Document Explorer Window select the main document body.

Step 2:  In the reading pane the delivery options should be displayed.

Step 3:  Either manually type in the address of your contact, or use your address book to find the contact you

wish to send your message to. 

Related Topics
What are accessories?
What is stationery?
How to create stationery
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How to set faxing options

Faxing options allow you to set options for the document you have selected to send out via fax.  To access the
faxing options, select the Options... button from the addressing screen.

The following options can be specified:

Coversheet
Using the Coversheet drop down list, you can access coversheets that are available on your Zetafax server
and add them to your fax message.  Having selected the coversheet:

·  Any text you have added to the Message body will be added to your coversheet's Notes field.
·  Any text added to the Subject field will be added to the Subject field.
·  The From field will use the information present in the User information tab of the main Zetadocs PDF

options pane. 

Note: You are also able to specify the From field from an embedded command. This value will override all the
other values. So the priority of the From value is:
· Embedded command 
· User information from main options
· Default options set up in Zetafax

Letterhead
In addition to being able to select in the Accessories window "Zetafax" from the Folder drop-down and
"Stationery" from the Type drop-down, you can also select a letterhead from the fax options dialog. 

Using the Letterhead drop down, you can access all the available letterheads from Zetafax. 

Charge code
If you have an individual or departmental charge codes set upi on the Zetafax server, you will need to add this
code in the box provided in order to allow your fax to be sent correctly.  
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Hold for preview
This tick box allows you to preview your fax within the Zetafax Client before sending it to your list of
recipients.

Resolution
These options allow you to choose the resolution of the file that is going to be sent by fax:
· Draft – low quality fax output (Standard mode 100/200 dpi)
· Normal – the standard fax formal (depends on the system configuration)
· High – High quality fax output (Fine mode 200x200 dpi)

Priority
These options allow you to set the urgency of your fax to:
· Normal - Queues the fax at the server to be sent in the order the server receives them
· Urgent – Sends the fax to the front of the server queue
· Background – Queues the fax at the server to be sent only when there are no other faxes waiting
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How to add stationery to your document  

Adding stationery to your document, is a quick way of creating a professional feel to your document.

Stationery can be applied to single pages of your document, sections of your document, or to your entire
document depending on your document content.

To add stationery to your document follow the steps below:   

Step 1:  Select the document you wish to add stationery to from the document explorer window.

Step 2:  Select Accessories from the top menu. 

You will notice a new panel open on the right hand side of your application window. 

Step 3:  From the Accessories Window, select "Stationery" from the Type drop down. 

This will list all the stationery available in the current folder.

Step 4:  Select the stationery you wish to apply.

Step 5:  The stationery can now be added:             

a) To add your stationery to a single page of your document, drag your stationery using the left mouse button

and drop it onto the desired page in the thumbnail view.

b) To add your stationery to a section of your document press the Apply button in the accessories screen.

c) To add your stationery to your entire document, drag your stationery using the left mouse button and drop

it onto the document in the Document Explorer Window.

Related Topics
What are accessories?
What is stationery?
How to create stationery
What is the document explorer window?
What is the thumbnail view?
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How to add an attachment 

Document attachments can be added to your document. These attachments will then be included in the PDF
that you create in the order the you specify.

To add a document attachment to your document follow the steps below: 

Step 1:  Select the Accessories option from the toolbar at the top of your application window. 

Step 2:  From the options in the top left of the accessories options window select Attachments.

Step 3:  To attach a document simply select the add button in the accessories panel.

Related Topics
What are accessories?
What are attachments?
How to create an attachment
How to customize an attachment
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How to use a document template 

Like Stationery and Attachments, document templates are accessible using the accessories Window, or using
embedded commands.  

Step 1: Open the document entitled Sample Letter.doc using Microsoft Word.  You can find this document in
the Samples folder accessed under the Zetadocs directory in your start menu.

Step 2: Print the document to the Zetadocs PDF printer.  The Zetadocs PDF software will display your
document.

Step 3: Click on the Accessories button, or choose View | Accessories Window.  Selected the folder where you
saved your template, and select Templates from the Type drop down.

Your template entitled Sales quotation will be visible.  Highlight it and click Apply.  The stationery and any
attachments will automatically be added to your document.  If you included any email sending options such as
a message body, or subject line, it will be visible as shown in the screen below.

Step 4: Click Send to send the document.
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Related Topics
What is a document template?
How to create a document template
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How to include PDF files  

PDF files, can be added to your document in two different ways as part of the main PDF document produced
by Zetadocs PDF or by attaching the PDF file to your email message using your email program (such as
Outlook).

To attach a PDF as part of the main PDF document

Step 1: Create your document.

Step 2: Select the Accessories option from the toolbar at the top of your application window. 

Step 3:  From the options in the top left of the accessories options window select PDF.

Step 4: To attach a PDF simply select the PDF you wish to add from the displayed list, then click the add
button in the accessories panel.

Related Topics
What are accessories?
What are PDF files?
The benefits of using PDF documents
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How to combine multiple documents

Documents appearing in the Zetadocs document explorer window, can be combined using the Combine
Zetadocs documents command to create a single document.  

To combine multiple documents:

Step 1: Print your documents to the Zetadocs PDF printer so that they appear in the Zetadocs document
explorer window.

Step 2: Select the Combine option from the Zetadocs toolbar and click “Combine Zetadocs documents”.

Step 3:  From the Combine Zetadocs documents dialog, click the ‘Add’ button.  The Add Documents dialog lists
all documents that exist in the document explorer window.  You can select multiple documents by holding
CTRL and clicking on them.  When you have finished your selection, click ‘Add’.

Step 4: The documents you have selected appear in the list box as shown in the screen below.  You can
specify the order to combine the documents using the Up and Down arrows or reverse the current order by
clicking ‘Reverse’.  

Step 5: Finally, you can choose whether to combine the selected documents to an existing document in the
document explorer window, or to create a new Zetadocs document.  
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Related Topics
Combine multiple files
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How to combine multiple files  

Any file, such as a Word document or Excel spreadsheet can be combined to any number of other files to
create a single document within Zetadocs using the Combine files command.  

To combine multiple files:

Step 1: Select the Combine option from the Zetadocs toolbar and click “Combine files”.

Step 2: From the Combine files dialog, click the ‘Add’ button.  Zetadocs prompts you to browse for any file
visible within windows explorer.

Step 3:  You can select multiple files by holding CTRL and clicking on them, or you can add other files from
different folders by clicking the ‘Add’ button.  

Step 4: The files you have selected appear in the list box as shown in the screen below.  You can specify the
order to combine the files using the Up and Down arrows or reverse the current order by clicking ‘Reverse’.  

Step 5: Finally, you can choose whether to combine the selected documents to an existing Zetadocs document
in the document explorer window, or to create a new Zetadocs document  

Related Topics
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Combine multiple documents
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How to convert a document to a PDF attachment 

Use the instructions below to convert any document into a PDF attachment which can then be sent from
Zetadocs.

Step 1:  Print your document to the Zetadocs PDF printer.

Step 2:  From the File menu select the Save as PDF option.

Step 3:  Choose the location  to save your file and the title you want your PDF to have. 

Step 4:  Select the Save option to create your PDF.

Related Topics
What are PDF files?
The benefits of PDF
How to include PDF files
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How do I send an existing PDF attachment 

Any PDF document that you have already produced can be sent to a recipient using the Add to new
document option.  This will create a new Zetadocs document (named the same as your PDF attachment) and
allowing you to add other attachments, stationery and email sections as standard.

To use this option:

Step 1:  Select your PDF attachment using the accessories window.

Step 2:  Right click your mouse and select the Add to new document option.

Your document will now appear within the document explorer window.
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How to re-submit a sent PDF 

Any PDF document that you have already sent using Zetadocs can be re-submitted you are using the archiving
feature of Zetadocs.  This is done using the Re-Submit option.  This will create a new Zetadocs document
(named the same as your original PDF document), storing all information, attachments and stationery as the
original document.  This allows you to add other attachments, stationery and email sections as required before
sending the document again.

To use this option:

Step 1:  Open the accessories window, and select ‘PDF document’ from the Type drop down.

Step 2:  From the Folder drop down, select Browse and browse to the network folder where the Zetadocs
archive is located.  If you are not sure of the location, please contact your network administrator.

Step 3:  Select the PDF document that you wish to resend and Right-click your mouse and select the 
Re-Submit option.

Your document will now appear within the document explorer window.

Related Topics 
How to archive your sent documents
How to set up the Zetadocs Archive using the configuration program
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How to add a scanned document  

If you have a scanner attached to your computer, you can scan paper documents directly to the Zetadocs
client.

To do this:

Step 1: Use the scan button available in the client, which is available from either from the Zetadocs toolbar,
or the file menu: 

 Scan button on main toolbar

Step 2:
a) If a scanner has been detected, your scanning software will start automatically enabling you to

configure your default scanning preferences:
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An example of scanning software options

b) If more than one scanner is detected, all scanners will be displayed in a list to allow you to select
the most suitable:

Multiple scanners being displayed

Step 3: Use your scanning software to capture the scanned image.

Step 4: Close your scanning application widow 

Your document will appear in the document explorer window allowing you to add attachments, stationery and
templates to your scanned document before sending.
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How to send documents as a batch

Sending documents as a batch allows you to send documents like invoices or letters to several recipients at
the same time, on a mouse click.

How to send your documents as a batch 

Step 1: Open the document that you wish to send, as a batch to several recipients.

Step 2: Add the embedded commands to your document. (For more information on how to create a mail
merge template that you can then use with Zetadocs to send out as a batch to a group of your clients, please
see the tutorial: Sending documents as a batch) 

Step 3: Print your document to the Zetadocs printer. The Zetadocs Client will be launched and the batch is
displayed in the document explorer window. 
 
The batch is given a name derived from the name of the document, the date and time the batch was
submitted to the Zetadocs Client, for example, Microsoft Word - Invoices.doc [01-02-2007 10.15]. 

When you click on the batch in the document explorer window, the view changes from the reading pane
to the batch preview pane. 

Step 4: To send the whole batch, select it in the document explorer window and you can either click Send on
the toolbar, or select Send All from the File menu. 

You can send a single document by pressing CTRL+E keys.

How to put documents on hold

If you do not want to send a particular document with the whole batch, you can put this document on hold,
until you are ready to send it out. To do this:

Step 1: Select the batch in the document explorer window.
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Step 2: In the batch preview pane, select the particular document that you wish to put on hold

Step 3: Right-click on the document, and click hold. The following icon will be displayed:  in first column of
the table and this will also be reflected in the document explorer window to show you which documents are on
hold. When you are ready to send the document, click hold again to unhold it and the icon will disappear. Or
you can also double click on the icon in the cell to change the status.

Step 4: You can send the selected document by right clicking on the document and clicking send.

If you try to send held documents, you will be asked to confirm your action:

How to delete a batch 

To delete a batch:

Step 1: Select the batch in the document explorer window.
Step 2: You can either:

(a) Click File > Delete Batch or 
(b) click the delete button on the toolbar or
(c) click the down arrow next on the Delete icon on the toolbar and select Delete batch or
(d) right-click on the batch in the document explorer window and select delete batch or
(e) press delete on your keyboard.

Note: If you select delete all when you click on the drop down arrow on the delete button, this will delete all
documents and batches in the document explorer window.

Step 3: The Deleting batch documents dialog is displayed and you will be asked to confirm your action.

How to delete a document or selected documents

To delete selected document(s) in the table view:

Step 1: Select the document or all the documents you wish to delete in the table view
Step 2: You can either:

(a) click on the Delete Selected Documents from the File menu or 
(b) press the delete key on your keyboard or
(c) press the CTRL + D keys

Related topics

What is a batch?
What is the batch preview pane?
What embedded commands are there?
How to automate document sending
Sample Embedded Command documents
How do I print to the Zetadocs PDF printer?
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What are embedded commands?

Embedded commands are lines that can be added to your document before printing to Zetadocs PDF that allow
you to automate document sending.

By using embedded commands, you can:
· Add message options to your document such as:

o Email addresses

o Fax numbers

o Subject lines

o Email body

o Fax Coversheet text

· Add options to your document such as:

o Stationery

o Attachments

o Coversheets

o Templates

· Add actions to your document such as:

o Excluding unwanted pages

o Splitting documents for multi-document sending

o Saving your documents in a specific archive location

o Saving your document with a specific file name

 
Why would you use embedded commands?
Embedded commands are used to make sending standard documents a simple process.  By creating templates
within your standard word processing application, you can quickly and simply produce documents such as
sales quotes that contain all the information you require.  

Once a template has been produced this can then be used by all members of a team or company ensuring
consistency of information.  Additionally if a document or procedure is changed, this can then be updated in
one centralized location.

Within the tutorial section of this help file you can find a number of examples of embedded commands being
used in everyday tasks:
· Mail Merge and Zetadocs 
· Sending Quotations from ACT!
· Sending personalized marketing mailshots from ACT!

The list of documents that can have embedded command templates applied to them will vary depending on the
type of business you are in, however, by taking the time to create these template, you can not only save your
organization a lot of time in the long term, you can also ensure that your corporate standard is maintained
across your company.

 Related Topics
Mail Merge and Zetadocs 
Sending documents as a batch
Sending Quotations from ACT!
Sending personalized marketing mailshots from ACT!
What are the embedded commands I can use?
How do I add embedded commands to my document?
Modifying ACT! Templates
Sample embedded command documents
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How do I add embedded commands to my document?

Embedded commands are pieces of information that can be processed by Zetadocs PDF if they are included
in your document.
 
Documents can be automatically sent directly from the program you are working in by adding Embedded
commands to your document. By using the Word add-in, users can quickly create documents that can be
sent to the Zetadocs PDF printer and sent. The embedded commands that can be used by Zetadocs PDF can
be found on the Insert ribbon.  These allow you to add stationery, and attachments directly from Word or
Excel.  In addition you can add sending and storage information allowing your document to be sent directly
from Excel and Word. 
 
The Embedded Commands specific Zetadocs PDF have been added to 3 different drop down galleries within
the Zetadocs group.  In addition, a subset of the Zetafax commands can be used if you need to send your
document to a fax recipient using the Zetadocs PDF client (these shared commands are marked by a shared
icon ()).
 
1.  Choose the embedded command you wish to add to your document from the Zetadocs Gallery.
2.  If required, modify the command to replace any information enclosed in brackets '<' and '>'.
 
For example:
 
%%[email: <email address>]
 
Should be modified to:
 
%%[email: ssmith@smithandsons.com]
 
3.  When you have added all the embedded commands you require, and your document is complete, send
your document to the Zetadocs PDF using the Send to Zetadocs PDF button.
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What Embedded commands are there?

Creating a Standard Embedded Command Template

The following action commands can be added to your document template without needing to be changed: 

%%[startdocument]

%%[excludepage]

%%[startbodytext]

%%[endbodytext]
 
When any document is printed that contains any text between the lines %%[startbodytext]and
%%[endbodytext] will be automatically added to the body of your email. 

For examples of documents that can be sent using embedded commands please click here. 

Related topics
Delivery options
Message commands
Options commands
Fax Options commands
ACT! database options commands
Batch options commands
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What Embedded commands are there?

Customizing your Embedded command template

If you wish to add set email addresses and subject lines or accessorize your template  these can also be added
to your template document.

Delivery options 
If you have a licence for Automation, please see automation commands for more Delivery Options.

Email
To add email addresses to a file use the command:

%%[email:«Email_address»]

%%[emailcc:«Email_address»]

%%[emailbcc:«Email_address»]

Where «Email_address» can either be set up as a mail merge field for multiple sending, or changed to a set
address if you do not wish to use mail merge. You can add multiple addresses by separating each address with
a semicolon for example:

%%[email: example1@test.com; example2@test.com]

Fax
If you have Zetafax installed on your server, and the outlook extensions setup, you can also send your PDF
document as a fax message.

To add a Fax number to a file, use the command:

%%[Fax: <<number>>, <<name>>, <<company>>]

Where  <<number>> is the fax number you wish to send your fax to, <<name>> is the name of the fax
recipient, and <<company>> is the company name you wish to send your fax to.   Like the email address
command, you can set this up to merge your fax numbers or enter individual numbers.

For example:

%%[Fax: 555 453 4545, Sam Smith, Widgets Inc.]
 

Print
To print a copy of your PDF, use the command:

%%[Print: <<printer name or path>>]

Where <<printer name or path>>  is the specified printer name from the printers list or the path to a printer
with a specific UNC path name on the network.

Multiple delivery options
If you have a mail merge source, with several delivery options, you can set your mail merge template to
deliver your messages in different ways for different recipients.  This is done using the command:

%%[DeliveryOption: <<value>>]

Where <<value>> is set up via mail merge to be one of the following options:

mailto:example2@test.com
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Value Description

Email Document will be sent via email.

Fax Document will be sent via fax.

Print Document will be printed.

EmailandPrint Email your document and print a copy.

EmailandFax Email and Fax your document.

FaxandPrint Fax your document and print a copy. 
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What Embedded commands are there?

Message commands

Subject
The Subject field allows you to specify a line for the subject field of your message. This is particularly useful
if you wish to completely automate your message sending, for example if you are creating a mail merge with
many recipients.

To add a subject to a file use the command:

%%[subject:<subject>]

For example: 

%%[subject: Today's meeting notes]

Name
You can specify the name of the recipient by the adding the following command:

%%[name:<recipient_name>] 

where <recipient_name> is the name of the person you are sending the document to. 

Organization
You can specify the name of the organization by using the following command:

%%[organization: <organization_name>]

where <organization_name> is the name of the company where you are sending the document to. 
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What Embedded commands are there?

Option commands 
Accessories such as stationery, attachments and document templates can be added directly to your
document. 

To add an accessory: 

Step 1:  Select the accessory you would like to add.  

Step 2:  Right click your mouse to display the Actions menu:

Step 3:  Select the Copy Automation Command option.

Step 4:  In your main document, select paste.

The command for selecting that accessory will be added to your document.

You can also use the following commands:

Add stationery

%%[stationery: <stationery>]

Where <stationery> equals the stationery to include located in a public folder, private folder or full UNC path
to the template.

Advanced stationery options
It is possible to specify further options when applying stationery to multi-page documents, such as:

%%[stationery: Equisys stationery.zds, 3]

Applies stationery to a single page, in this instance page 3 only.

%%[stationery: Equisys stationery.zds, 3-]

Applies stationery on page 3 and all subsequent pages until the end of the document.

Add an attachment

%%[attachment: <attachment>]

Where <attachment> equals the attachment to include located in a public folder, private folder or full UNC
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path to the template.

Add a template

%%[template: <template>]

Where <template> equals the document template to include located in a public folder, private folder or full
UNC path to the template.

Add a PDF attachment

%%[PDF: <PDF filename>]

Where <PDF filename> equals the PDF attachment to include located in a public folder, private folder or full
UNC path to the template.
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What Embedded commands are there?

Fax option commands

Coversheet
You can set one of your Zetafax coversheets to be used for all fax recipients by using:

%%[Coversheet: COVSHEET]

Where COVSHEET is the name of a coversheet stored on your Zetafax server.

Letterhead
You can set a Zetafax letterhead to be added to your Zetadocs PDF document by using:

%%[Letterhead: LETTHEAD]

Where LETTHEAD is the name of a letterhead stored on your Zetafax server.

Resolution
You can change the quality of fax sent by using:

%%[Quality: <quality>]

Where <quality> is one of the following:

· HIGH - best quality
· NORMAL - standard quality
· DRAFT - low quality
 
Chargecode
You can set the chargecode of a fax (if this has enabled on your Zetafax Server) by using:
 
%%[Charge: C1000]

Where C1000 is the charge code for your department or user account.

Preview
You can hold your fax for preview by using:

%%[Preview]

Username
You can set your Zetafax username by using: 

%%[From:<username>] 

Where <username> is your Zetafax username.

Note: This command overrides Zetadocs PDF options username

Priority 
You can set the priority of you fax by using:

%%[Priority: <priority>]

Where <priority> is either:
· High
· Normal
· Background
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What Embedded commands are there?

ACT! database option commands

Adding history item to ACT! contact
The following command instructs Zetadocs PDF to store a history item to a contact in the ACT! database. This
will happen just after Zetadocs PDF sends the email to the contact.

%%[ActContactHistory: <your company>, <contact name>, <contact email>]

Where <your company>, <contact name> and <contact email> are replaced by ACT! fields as follows:

<your company> : My Record – Company (The name of your company as specified in your ACT! database).
<contact name>: Contact – Contact 
<contact email>: Contact – E-mail

Select ACT! contact history options
The following command allows you to configure what information is stored on the contact history in the ACT!
database.

%%[ActHistoryOptions: <message options>, <attachment options>]

where <message options> is one of:

· SubjectAndMessage – store both email subject and message body in history
· Subject – store only subject in history
· None – store neither subject not message body in history

and <attachment options> is one of:
Attachment – store PDF attachment in message history
None – do not store attachment in message history
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What Embedded commands are there?

Automation commands

Note: These embedded commands apply specifically to the automation add-on and will work only if
you have purchased a licence for automation.

Batch
You can specify the name of the batch by the adding the following command:

%%[batch: <name>] 

where <name> is the name of the batch. This name will be displayed in the column entitled Name, of the
batch preview pane. Specifying a batch name is optional.

Preview
You can either hold your documents in the batch for preview in the Zetadocs Client or send them
automatically. This will override the Preview batch before sending option you have already set in the
Automation tab from Tools menu>Options. To override the Hold for preview option you had set as default,
you can this command:

%%[batchpreview:<on or off>]

specifying on means that the documents in the batch will be held for preview in the Zetadocs Client.

specifying off means that the documents in the batch will be sent automatically via the delivery options
specified. Only documents not sent successfully will remain in the Zetadocs Client.

Delivery Option  
You can specify delivery options for a batch, which will then act as a "failover" mechanism. This means that if
the document cannot be sent by the first method specified, for example if the email address is wrong, it will be
sent using the second method.  

%%[deliveryoption: Email, Fax, Print]

in the example above, the document will be sent by email first, if it is not sent successfully, then it will be sent
by fax. If not successful, the document will be sent to the printer. 

%[deliveryoption: EmailandFax]

in the above example, the document will be sent both by email and fax. Both the email address and fax
number are displayed in the column entitled Delivery of the batch preview pane.

%%[deliveryoption: Fax, Print]

in this example, the document will be sent by fax first, if it is not successfully sent, then it will be sent to the
printer you specify. 

Archiving
%%[archivedocument: <on or off>] 

Specifying on or off means that your documents will be or will not be archived after sending respectively.

You can specify the content type by the adding the following command:
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%%[archivedocumenttype: <name>] 

where <name> is the content type name. 
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Sample Embedded Command documents

Sample code 1 - Embedded addresses to a single user 

%%[startdocument]
%%[email: hhunter@equisys.com]
%%[subject: sales query]
%%[template: test.zdt]
%%[excludepage]
%%[startbodytext] 

 Dear Customer.
 Thanks for your interest in our product. Please see attached PDF.
 Regards the Sales Team
 www.equisys.com 

%%[endbodytext]

Sample code 2 - Embedded addresses within a mail merge template 

%%[startdocument]
%%[email: «Email_address»]
%%[stationery: Equisys letterhead.zds]
%%[attachment: Getting started.zda]
%%[subject: Support contracts due for renewal]
%%[startbodytext]

  
Dear «Salutation» «Last_Name»,
It has come to our attention that your current contract is due to run out on the «day»th of
June 2005.
Please fill in the attached form should you wish to renew you policy.
With regards
Technical Support 

 %%[endbodytext]

Sample code 3 - Dynamic Fields within a mail merge template

An original document containing the following commands:

%%[field: salutation, Hal]
%%[field: company, Widgets Inc.]
%%[field: quote_number, 1234]
%%[field: myname, Sam]
%%[Outputfilename: Quotation %%[quote_number] for %%[company]]

Document Template

When merged to a document template containing the following text within the email body:

Dear %%[salutation, Sir/Madam],

I'm pleased to attach your quotation as discussed along with our conditions of sale and
product brochure. 

Our quotation number for your reference is %%[quote_number], please include this on your sales
order.

mailto:hhunter@equisys.com
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Regards,

%%[myname]

Expected Output

Zetadocs creates a PDF file called: Quotation 1234 for Widgets Inc.pdf
Zetadocs creates the following email message body:

Dear Hal,

I'm pleased to attach your quotation as discussed along with our conditions of sale and
product brochure. 

Our quotation number for your reference is 1234, please include this on your sales order.

Regards,

Sam

Sample code 4 - Documents sent as a batch 

Note: These embedded commands apply specifically to the Batch option and will work only if you
have purchased a licence for automation.

%%[startdocument]
%%[name: «Name»]
%%[organization: «Company»]
%%[email: «Email_address»]
%%[fax: «Fax_number»]
%%[deliveryoption:Email,Fax] 
%%[batchpreview:on]
%%[stationery: Equisys letterhead.zds]
%%[attachment: Getting started.zda]
%%[subject: Support contracts due for renewal]
%%[startbodytext]

  
Dear «Salutation» «Last_Name»,
It has come to our attention that your current contract is due to run out on the «day»th of
«Month» 2007.
Please fill in the attached form should you wish to renew you policy.
With regards
Technical Support 

 %%[endbodytext]

Related topics
What embedded commands are there?
How to automate document sending
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Introducing the Zetadocs Office Addin

The Zetadocs Office Addin allows you to integrate Zetadocs PDF functionality into the following Office
applications:
 
· Outlook
· Word
· Excel
 
These Addins are installed as part of the install process of Zetadocs PDF and will display differently
depending on which products you have installed. 
 
 The Zetadocs Outlook Addin
The Zetadocs Outlook Addin allows you to convert compatible attachments into single or multiple PDF
attachments.  These attachments can then be compressed into a zip file if required, before being sent to
your recipients.

 The Zetadocs Word and Excel Addins
The Zetadocs Word and Excel Addins allow you to convert your documents and worksheets into PDFs.  In
addition, you can add standard attachments and stationery to your document before saving or sending your
PDF via outlook as an attachment. 
 
In addition, by using the embedded commands, you can add attachments, stationery and send your
document automatically.  You can also use embedded commands to customize your document for use in mail
merging.
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Zetadocs Outlook Addin

The Zetadocs Outlook Addin allows you to convert compatible attachments into single or multiple PDF
attachments.  These attachments can then be compressed into a zip file if required, before being sent to
your recipients
 
The default options, which can be accessed from Tools > Options, allow you to set the default way in which
your documents are converted by Zetadocs PDF.  You can set these options to specify:
 
· All compatible attachments to be converted on send.
· Whether attachments should be added to multiple or single PDF files.
· Whether attachments should be compressed into a ZIP file.
· Default names to be used for ZIP and PDF files.
· Settings for the conversion of different file types.
 
Note: Advanced conversion settings are only available if you are using the "Microsoft Save as PDF" 2007 add
in. 
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How do I...

These topics show you how to perform the tasks that are possible with the Zetadocs Outlook Addin.
 
Select a topic from the list below:
 
How do I convert an attachment?
How do I change the order of attachments?
How do I convert multiple attachments into a single PDF?
How do I zip my attachments to reduce file size?
How do I set the Zetadocs Outlook Addin options?
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How do I convert an attachment?

 
Any Office® based attachment that you add to an email message can be converted into either a single PDF
or multiple PDFs using Zetadocs PDF. 
 
Step 1: Attach your document to your email message in the usual manner.

Step 2: Next, start the Zetadocs PDF Wizard. There are two ways to start the Zetadocs PDF Wizard:

i)  When you click Send, the Zetadocs PDF Wizard will start up automatically if it detects an attachment
has been added to the message.    

ii)  Alternatively, you can manually start the Zetadocs PDF Wizard by selecting the Convert
Attachments button before you send the email.

These are default settings. To change the default settings see How do I set the Zetadocs Outlook Addin
options?

The Wizard will display the attachment that you have added to your message:        
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 Step 3: Click the Next button to start converting your attachment:
 
 

 

 
When conversion is complete, a new window will open, allowing you to view the PDF document you have
created:

 

 
 Step 4: You can scroll page by page through the thumbnail view of your PDF, by selecting the document
and using the arrow buttons underneath the thumbnail view to move between pages.

 Step 5: To view the created PDF, select the Preview button, and your PDF will be opened in Adobe
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Acrobat:
 

 
 Step 6: When you are happy with your created PDF, select Finish to exit the Zetadocs PDF Wizard and
attach your created PDF file to your message.
 
Related Topics
How do I change the order of attachments?
How do I convert multiple attachments into a single PDF?
How do I zip my attachments to reduce file size?
How do I set the Zetadocs Outlook Addin options?
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How do I change the order of attachments?

If you have selected multiple attachments, you can change the order in which they will appear after PDF
conversion.
 
 Step 1: Attach your document to your email message in the usual manner.

 Step 2: Next, start the Zetadocs PDF Wizard. There are two ways to start the Zetadocs PDF Wizard:

i)   When you click Send, the Zetadocs PDF Wizard will start up automatically if it detects an
attachment has been added to the message.     

ii)   Alternatively, you can manually start the Zetadocs PDF Wizard by selecting the Convert
Attachments button before you send the email.

These are default settings. To change the default settings see How do I set the Zetadocs Outlook Addin
options?

The Wizard will display the attachment that you have added to your message:  
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All attachments that are suitable for PDF conversion will be selected in the Select Attachments window. 

Step 3: Highlight an attachment by clicking your mouse on it.

Step 4: Use the up and down arrows to change the order of your attachments        
 
Related Topics
How do I convert an attachment?
How do I convert multiple attachments into a single PDF?
How do I zip my attachments to reduce file size?
How do I set the Zetadocs Outlook addin options?
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How do I convert multiple attachments into a single PDF?

If you have more than one attachment that you want to attach to your email message, you can have the
option to combine your attachments into a single PDF document or to create individual PDF documents of
each attachment.  This page deals with how to convert all your attachments into a single PDF.
 
Any Office® based attachment that you add to an email message can be converted into either a single PDF
or multiple PDFs using Zetadocs PDF. 
 
Step 1: Attach your document to your email message in the usual manner.

Step 2: Next, start the Zetadocs PDF Wizard. There are two ways to start the Zetadocs PDF Wizard::

i) When you click Send, the Zetadocs PDF Wizard will start up automatically if it detects an attachment
has been added to the message.     

ii) Alternatively, you can manually start the Zetadocs PDF Wizard by selecting the Convert
Attachments button before you send the email.

 
These are default settings. To change the default settings see How do I set the Zetadocs Outlook Addin
options?

The Wizard will display the attachments that you have added to your message:        
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Step 3: Choose the order in which you wish your attachments to appear within your PDF (Click here for more
information).

Step 4: Select the Convert attachments into a single PDF option, and type the name of your new PDF in
the text-box provided.

Step 5: Click the Next button to start converting your attachment:
 
 
 

 
When conversion is complete, a new window will open, allowing you to view the PDF document you have
created:
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Step 6: You can scroll page by page through the thumbnail view of your PDF, by selecting the document and
using the arrow buttons underneath the thumbnail view to move between pages.

Step 7: To view the created PDF, select the Preview button, and your PDF will be opened in Adobe Acrobat:
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Step 8: When you are happy with your created PDF, select Finish to exit the Zetadocs PDF Wizard and
attach your created PDF file to your message.
 
Related Topics
How do I convert an attachment?
How do I change the order of attachments?
How do I zip my attachments to reduce file size?
How do I set the Zetadocs Outlook addin options?
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How do I zip my attachments to reduce file size?

 
Adding attachments to your message can increase the file size dramatically.  This is not desirable as many
organizations have a maximum file size that they can receive.
 
One way of reducing the file size of documents is to compress them into a zip file.  The following instructions
will allow you to zip your attachments.
 
Most attachments that you add to an email message can be compressed into a single zip file using Zetadocs
PDF. 
 
Step 1: Attach your document to your email message in the usual manner.

Step 2: Next, start the Zetadocs PDF Wizard. There are two ways to start the Zetadocs PDF Wizard:

i) When you click Send, the Zetadocs PDF Wizard will start up automatically if it detects an attachment
has been added to the message. 

ii)  Alternatively, you can manually start the Zetadocs PDF Wizard by selecting the Convert
Attachments button before you send the email.

 
These are default settings. To change the default settings see How do I set the Zetadocs Outlook Addin
options?

The Wizard will display the attachments that you have added to your message:   
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 Step 3: Choose the order in which you wish your attachments to appear within your PDF (Click here for
more information).

 Step 4: Select the Compress attached files into a single zip file option, and type the name of your new
zip file in the text-box provided.

 Step 4: Click the Next button to start compressing your attachment.
 
Related Topics
How do I convert an attachment?
How do I change the order of attachments?
How do I convert multiple attachments into a single PDF?
How do I set the Zetadocs Outlook addin options?
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How do I set the Zetadocs Outlook Addin options?

You can set the Zetadocs Outlook Addin options to allow your Zetadocs PDF Wizard to perform in different
ways. To set your default options:

Step 1: Select Options from the Tools menu. This displays the Options dialog box:

Step 2: Select the Zetadocs PDF tab.   

Step 3: Set your default options:
 
Toolbar Options
· If you select Display the Convert Attachments button, the button will be added to your email
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message form, this allows you to convert attachments using the Zetadocs PDF Wizard. Each time you
have attachments you wish to convert, you can activate the Wizard using the Convert Attachments
button.

 
PDF Conversion Options
· If you select Automatically Convert attachments on Send, each time you send an email with

attachments Zetadocs will perform a PDF conversion.
 
· If you select Launch the Zetadocs Wizard on Send, this will set the Zetadocs PDF Wizard to run

anytime you send an email with attachments, allowing you to make modifications to the PDF conversion.

· If you select Prompt me before converting you will be asked to confirm that you wish to convert
attachments before sending. 

 
Zetadocs Wizard Options
· If you select Combine attachments into a single PDF file, this allows you to convert your

attachments to a single PDF as standard, and to set a name for your new PDF document.
 
· If you select Automatically compress attached files into a single zip file, all attachments that are

present will be added to a named zip file.
 

 
Related Topics
How do I convert an attachment
How do I change the order of attachments?
How do I convert multiple attachments into a single PDF?
How do I zip my attachments to reduce file size?
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Zetadocs Word and Excel Addins

The Zetadocs Word and Excel Addins allow you to send documents and worksheets that you have created
either by fax or as PDF attachments via email.
 
In addition, using the embedded commands, you can add accessories, add addressing options and send your
document directly from your application.
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How do I...

These topics show you how to perform the tasks that are possible with the Zetadocs Word and Excel Addins.
 
Select a topic from the list below:
 
How do I send my document as a PDF?
How do I add embedded commands to my document?
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How do I send my document as a PDF?

Once you have finished creating your document in Word or Excel, you can send your document to Zetadocs
PDF to add stationery, attachments and templates.  This ensures that all documents sent as a company or
department can not only be read by all recipients but also conforms to your company's document standards.
 
To convert your document to PDF simply select Send > Email using Zetadocs PDF found in the Office
menu, as shown below:

Note: For Office 2003 users, a toolbar button is installed in your standard toolbar. Click on the Zetadocs PDF
button.
 
Your document will be opened in the Zetadocs PDF Client.  This allows you to add stationery and any
attachments to your document.  Once your document is complete, you can add the addresses of your
recipients, and send your document via Outlook.
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Related Topics:
How to convert a document to a PDF attachment
How to add stationery to my document
How to convert a document to a PDF attachment
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How to integrate Zetadocs with ACT! 

About ACT! Integration
Act integration allows you to configure Zetadocs PDF to add a history item to an ACT! database every time you
send an email via Zetadocs PDF to an ACT! contact. The history item can contain the email subject, message
body, and sent document in PDF format. 

This section describes the steps involved to configure Zetadocs to integrate with ACT! 2005 and 2006.

Integrating Zetadocs PDF with ACT! 
To integrate Zetadocs PDF with ACT! 2005 and 2006, it is necessary to follow these steps:

Step 1:  Configure the ACT! database within Zetadocs

Step 2:  Modify any ACT! templates you wish to use with Zetadocs

Step 3:  Use ACT! to merge your documents and send them directly using Zetadocs

These steps are described in detail in the sections listed in the related topics.

Related Topics
Act Database Settings
Modifying ACT! templates
Sending Quotations from ACT!
Sending personalized marketing mailshots from ACT!
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Configuring ACT! databases

The first stage in configuring Zetadocs for use with ACT! is to configure ACT! databases.  This is done using

the Options dialog within Zetadocs.

ACT Options
Step 1: Select Options from the Tools menu in Zetadocs.

Step 2: Select the ACT! options tab to configure ACT! database connections. 

An ACT! database connection consists of a database filename (.PAD file), username, and password. A name is

automatically assigned to an ACT! database connection – this is taken from your company name (stored in "My

Record" in the ACT! database).

Note: Please ensure you have a "Company" name set on the "My Record" contact. This is not required for Act

but it is required for Zetadocs PDF.

Zetadocs PDF supports multiple ACT! databases, therefore you can add multiple databases at different

locations, using different usernames and passwords. Note that Zetadocs PDF cannot use more than one

database which has the same company name (from "My Record").

Note: If this dialog is disabled, then Zetadocs PDF did not detect an ACT! 7 or ACT! 8 installation on your
system.
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Step 3: Click on the Add button to add an ACT! database connection.  This opens the ACT! database
configuration dialog.

Step 4: Click on the Edit button to change an ACT! database connection. You can change the database

filename or location, username and password. You will need to update the connection if your company name

has been changed in the database.

Clicking on Remove, removes an ACT! database from the list.

ACT! Database configuration
The ACT! Database Configuration form allows you to specify (add or edit) an ACT! database connection. 

Step 5: Browse to the location of your ACT! database file. This will have a .PAD file extension. It is the same
file you select within  ACT!from the File | Open Database... menu.

Step 6: If required, enter the username that you use to log on to the ACT! database. If a username is not
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required, leave this field blank.

Step 7: If required, enter the password that you use to log on to the ACT! database. If a password is not
required, leave this field blank.

Step 7: Click OK. Zetadocs PDF will use the details you entered to log on to the ACT! database. It will read
your company name (from "My Record") and use this as the database connection name.

The next step to configure Zetadocs with ACT! is to modify ACT! templates.

Related Topics
Modifying ACT! templates
How do I integrate with ACT?
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Modifying ACT! templates 

Editing ACT! templates

Zetadocs PDF supports ACT! templates created in Microsoft Office Word 2003.  This section describes how to

modify an existing template to use basic commands to send PDFs by email to single and multiple recipients.  

Step 1: Open the ACT! application.

Step 2: Select Write | Edit Template from ACT! Menu bar.

Step 3: Select the template you wish to edit e.g. for quotations, choose Quote.adt from the list.

Adding history item to ACT! contact
The following command instructs Zetadocs PDF to store a history item to a contact in the ACT! database. This
will happen just after Zetadocs PDF sends the email to the contact.

%%[ActContactHistory: <your company>, <contact name>, <contact email>]

Where <your company>, <contact name> and <contact email> are replaced by ACT! fields as follows:

<your company> : My Record – Company (The name of your company as specified in your ACT! database).
<contact name>: Contact – Contact 
<contact email>: Contact – E-mail

You can add this command by hand, using the ACT! menu to assign the Merge fields or using the Word
ZetadocsPDF toolbar, which will add the correct fields automatically. The final command should look something
like this:

%%[ActContactHistory: <MY:Company>, <Contact>, <Email>]

The command identifies the ACT! database where the contact is stored – this must match one of the ACT!
databases configured in the Zetadocs PDF Options tab – see ACT! Integration.

Select ACT! contact history options
The following command allows you to configure what information is stored on the contact history in the ACT!
database.

%%[ActHistoryOptions: <message options>, <attachment options>]

where <message options> is one of:

· SubjectAndMessage – store both email subject and message body in history
· Subject – store only subject in history
· None – store neither subject not message body in history

and <attachment options> is one of:
Attachment – store PDF attachment in message history
None – do not store attachment in message history

For example, the following command stores the subject and attachment in the message history, but does not
store the message body:

%%[ActHistoryOptions: Subject, Attachment]

Use with other embedded commands
The embedded commands described above can be added to ACT templates alongside other Zetadocs
embedded commands to fully automate PDF document creation and delivery.  This is described in the Tutorial:
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Sending Quotations from ACT!.

Related Topics
Act Database Settings
How do I integrate with ACT!?
Tutorial: Sending Quotations from ACT!
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How to create stationery 

Electronic stationery can be created easily in any program that can support graphics.

Step 1:  Add all logos and information that you would like to see in your stationery.

Step 2:  Print to the Zetadocs PDF printer. 

Step 3:  Use the reading pane to check the layout of your stationery.

Step 4:  If you are happy with the look of your stationery, then the stationery can be saved using the Save as

Stationery option found in the file menu:

Step 5:  This will open the Save As menu windows, and allow you to choose a file name for your stationery. 

Step 6:  Select the Save  option to save your stationery.

This stationery can now be applied to any documents printed to Zetadocs PDF.

Hints and Tips
 
Remember that any stationery you apply to a document will be placed behind the content on that page. 

This means that you will need to position the content for stationery in areas that are unlikely to be used in
your main document. 

Related Topics
What are accessories
What is stationery
Tutorial 2: Creating stationery
How to add stationery to your document
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How to customize a document attachment 

Just like normal documents that have been sent to Zetadocs PDF, before you save an attachment you can
apply stationery to it. 

This ensures that your attachment is always sent out with the correct layout and appearance. To do this simply
print your attachment to Zetadocs PDF apply your stationery then re-save your attachment.

In order to customize an attachment that is already present within Zetadocs follow the steps below:

Step 1: Print a blank document to Zetadocs.

Step 2: Attach your attachment to the blank document.

Step 3: Add the stationery you wish to be present on the attachment.

Step 4: Remove the original blank page from your attachment by clicking on the thumbnail (small picture) of
the blank page, right clicking your mouse and selecting delete page.

Step 5: When you are happy with the changes you have made to your attachment, select the save option from
the top menu and select the save as attachment option.  

Related Topics
What are accessories?
What are attachments?
How to add an attachment to a document
How to create a document attachment
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How to store sent documents in the document explorer window 

Documents sent to the Zetadocs PDF application are stored in the document explorer Window. This is found on
the left hand side of your application window:
  
The default option is to remove items from the document explorer Window as soon as they have been sent,
however this does not need to be the case:

Step 1:  From the menu options along the top of your Zetadocs application window select the Tools option,
and select Options from the drop down list. 

This will open the Options dialogue box.  Ensure that the General tab is selected:    

 

Step 2:  Deselect the Delete document after send to stop files being automatically deleted after they are sent.
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How to create a document template 

Using the Zetadocs document template wizard creating document templates that you can use to send
documents in a standard manner can be done both quickly and simply. 

The following steps need to be performed: 

Step 1:  Select the Create Document Template option from the Tools menu at the top of your program
window:

Step 2:  The first screen that is displayed allows you to choose the attachments you would like to include in
your document template. This allows you to add either single or multiple attachments. When you are happy
with your selection, select the Next button to continue. 

Step 3:  The second screen of the document template wizard allows you to choose any stationery that you
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would like to automatically apply to any documents sent with this document template. You can choose a
stationery type, or opt not to apply stationery to your main document. To add stationery, select the type you
wish to apply and select the add option.  When you are happy with your selection, select the Next button to
continue. 

Step 4:  The third screen allows you to add email addresses to the template. This may be useful in situations
where other members of staff will need to be notified of certain types of documents, for example invoices sent
out by the sales team that need to be seen by the accounts department.  By using a dynamic field, you can
link your template to a database (for example using ACT!), this will allow you to automatically add the email
address of your recipient.  See How to create a document template with dynamic fields.

Step 5:  Having ensured that you have added all the items that you wish to enclose in your template, use this
screen to check the items are correct, add a class type if required (a way of dividing up your documents for
archiving), and save your template in your Zetadocs accessory folder. 
 
Your template is now ready for use.

Related Topics 
What is a document template?
What is electronic stationery?
What is an attachment?
How to create stationery
How to create a new document attachment
How to create a document template with dynamic fields.
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How to create a document template with dynamic fields

A dynamic field is a field that can change depending on the information that you provide, so for example if you
are using a database such as ACT! a dynamic field can be added that differs for each record.  Adding dynamic
fields to your Zetadocs PDF templates allows them to be personalized for use with large scale document
production.

Delivery Information
Embedded commands within the template
You can add dynamic fields to the email properties page of your document template:

These dynamic fields must be set up in the following format:

%%[Field: <fieldname>, <defaultvalue>]

This command can be used within the delivery information in the recipients, subject and body text of the
email.

Where:
Fieldname is any descriptive word for your field, but with no spaces e.g.  firstname
Defaultvalue is the value you wish to be added if this field is not present in your data source.
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 The fields can be declared as %%[fieldname, defaultvalue] or simply %%[fieldname] e.g.
%%[firstname, customer]. 

Example:
%%[Field: firstname, customer]

Having set up your document template, these fields need to added to your mail merge document and merged
with your data source.

Example:

%%[Field: firstname, Harry]

If the value of the field is not found in document, then the embedded command will use the default value and
if the default value has not been specified then the text will be left as it was defined. So in the above example
if the document has defined a dynamic field as firstname then it will be replaced with the value Harry, if not
then it will replace it (if it has been declared) with customer.

Dynamic fields can be combined with the other embedded commands. You can use these fields to put merge
values in any set embedded command. 

Example:

%%[Field, name, Harry]
%%[Field, company, Widgets Inc.]
%%[OutputFilename: %%[company] - %%[name] ]

The output filename of the document that includes the above embedded commands will be “Widgets Inc. –
Harry”. As before, you can also add a default value. 

For example:

%%[OutputFilename: %%[company] - %%[firstname, Customer]]

So the output filename of the document this time will be “Widget Inc. - Customer”, since the dynamic field 
firstname was not defined in the document.

 Note that only one level of nested dynamic fields is supported. so the following command would be invalid:

%%[OutputFilename: %%[company, %%[name]] - %%[name] ]

Related Topics
Sample embedded command documents
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Example uses of dynamic fields

Adding dynamic fields to your Zetadocs PDF templates can deliver impressive results with both the
personalization of the PDF document itself and the accompanying email.  

Example 
An original document containing the following commands:

%%[field: salutation, Harry]
%%[field: company, Widgets Inc.]
%%[field: quote_number, 1234]
%%[field: myname, Sam]
%%[Outputfilename: Quotation %%[quote_number] for %%[company]]

Document Template
When merged to a document template containing the following text:

Dear %%[salutation, Sir/Madam]
I'm pleased to attach your quotation as discussed along with our conditions of sale and product brochure. 
Our quotation number for your reference is %%[quote_number], please include this on your sales order.
Regards,
%%[myname]

Expected Output
Zetadocs creates a PDF file called: 

Quotation 1234 for Widgets Inc.pdf

Zetadocs creates the following email message body:

Dear Harry
I'm pleased to attach your quotation as discussed along with our conditions of sale and product brochure. 
Our quotation number for your reference is 1234, please include this on your sales order.
Regards,
Sam
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How to archive your sent documents

With Archiving enabled from the configuration program, all your sent PDFs are archived automatically.

Click here for more information on how to set up the archive from the configuration program. 

How to view an archived PDF
Step 1: Select the accessories option from the toolbar.

Step 2: Select the email archive option from the folder list.

Step 3: Browse the folders listed to locate your document.

Step 4: Double click your PDF document and you can view its contents.

How to resubmit an existing PDF for sending
Any PDF document that you have already sent using Zetadocs can be re-submitted if archiving has been set
up.  This is done using the Re-Submit option.  This will create a new Zetadocs document  (named the same
as your original PDF document), storing all information, attachments and stationery as the original document. 
This allows you to add other attachments, stationery and email sections as required before sending the
document again.

To use this option:

Step 1: Select your PDF attachment using the accessories window.

Step 2: Right click your mouse and select the Re-Submit option.

Your document will now appear within the document explorer window.

How to add a sent PDF to another document
Step 1: Select your PDF attachment using the accessories window.

Step 2: Right click your mouse and select the Add to Document option.

What information can I view about an archived PDF
As standard, the following information is stored for each of your archived documents:

· Document Name
· Date Created
· User Name
· Recipients
· Email Subject

To view this information:

Step 1: Select your PDF attachment using the accessories window.

Step 2: Right click your mouse and select the Properties option.

 

 Related Topics 
How to re-submit a sent PDF
How to set up the Zetadocs Archive using the configuration program
What is Archiving?
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How to create a new document attachment

Creating document attachments allows them to be saved and attached to as many documents as you need to.
Document Attachments can come from any MS Office based program, and be single or multi page. 

This can be done following the steps below: 

Step 1:  Print the document you would like to use as an attachment to the Zetadocs PDF printer.

Step 2:  Select the Save option from the top toolbar.

Step 3:  Choose the As Attachment option.  

Step 4:  Select a file name that will be easily recognizable and save your file either in your local Zetadocs PDF
folder should it be for only your use, or in a shared folder on your network should other people need to use it. 

For example: 

L:\Equisys\Zetadocs PDF\Getting Started.zda

Your document will now be saved as an attachment. 

Related Topics
What are accessories?
What are attachments?
How to add an attachment to a  document
How to customize an attachment

 



91

© 2008 Equisys plc.  All rights reserved.  All third-party trademarks are acknowledged

How to change the document explorer settings 

The document explorer settings for Zetadocs PDF allow you to define the behaviour of the document explorer
window during the sending process.  To change the default settings, follow the instructions below.

Step 1:  From the Tools drop down menu select Options, the Options dialog box will be displayed.

 Ensuring that the General tab is selected the general settings will be displayed:

Step 2:  The Delete document after send option in the Document Explorer Settings section allows you to
specify whether you wish to store documents in the document explorer window after sending or whether they
should be deleted. The Confirm file deletion option will prompt you before deleting any documents in the
document explorer window.

Step 3:  If you wish to preview an individual message or several messages sent to Zetadocs as a batch, then
select the Preview document before sending option.

When you have made your changes, click the OK button to action them.  

A detailed description of the options can be found here:
Configuration options are there?
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Related Topics 
Document Explorer 
Configure email integration settings 
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How to configure email integration settings

The general settings tab within Zetadocs allows users to configure settings for their mail server, if you are
using an SMTP mail server or Lotus Domino mail server.  This is described in more detail below.

To specify mail server settings:

Step 1:  From the Tools menu select Options.  The Options dialog box will be displayed and the General Tab
will be selected.

Step 2:  Select your method of email integration. 

If you are using an SMTP mail server:

Step 3:  Highlight Send Via SMTP and click on the Server Settings button.  The following dialog is displayed.

Step 4:  Enter the configuration information for your SMTP server including user name and password and click
OK.  

If you are using a Lotus Domino mail server:

Step 5:  Highlight Send Via Lotus Notes and click on the Server Settings button.  The following dialog box is
displayed.
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Step 6:  Enter the configuration information for your Lotus Domino server including user name and password
and click OK.  
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How to configure PDF file options settings

The general settings tab within Zetadocs allows users to configure PDF file options settings. This is described in
more detail below.

The PDF file options available are:

Smaller file size - This option allows you to apply pdf compression to the pdfs produced by Zetadocs Client,
which are usually larger compared to other pdf generation applications..

Better image quality - This option gives you better quality of image, but the pdf output will be larger.
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How to change the user information settings

The User Information settings on the General tab allows you to set your Zetafax Username.
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Configuring ACT! databases

The first stage in configuring Zetadocs for use with ACT! is to configure ACT! databases.  This is done using

the Options dialog within Zetadocs.

ACT Options
Step 1: Select Options from the Tools menu in Zetadocs.

Step 2: Select the ACT! options tab to configure ACT! database connections. 

An ACT! database connection consists of a database filename (.PAD file), username, and password. A name is

automatically assigned to an ACT! database connection – this is taken from your company name (stored in "My

Record" in the ACT! database).

Note: Please ensure you have a "Company" name set on the "My Record" contact. This is not required for Act

but it is required for Zetadocs PDF.

Zetadocs PDF supports multiple ACT! databases, therefore you can add multiple databases at different

locations, using different usernames and passwords. Note that Zetadocs PDF cannot use more than one

database which has the same company name (from "My Record").

Note: If this dialog is disabled, then Zetadocs PDF did not detect an ACT! 7 or ACT! 8 installation on your
system.
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Step 3: Click on the Add button to add an ACT! database connection.  This opens the ACT! database
configuration dialog.

Step 4: Click on the Edit button to change an ACT! database connection. You can change the database

filename or location, username and password. You will need to update the connection if your company name

has been changed in the database.

Clicking on Remove, removes an ACT! database from the list.

ACT! Database configuration
The ACT! Database Configuration form allows you to specify (add or edit) an ACT! database connection. 

Step 5: Browse to the location of your ACT! database file. This will have a .PAD file extension. It is the same
file you select within  ACT!from the File | Open Database... menu.

Step 6: If required, enter the username that you use to log on to the ACT! database. If a username is not
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required, leave this field blank.

Step 7: If required, enter the password that you use to log on to the ACT! database. If a password is not
required, leave this field blank.

Step 7: Click OK. Zetadocs PDF will use the details you entered to log on to the ACT! database. It will read
your company name (from "My Record") and use this as the database connection name.

The next step to configure Zetadocs with ACT! is to modify ACT! templates.

Related Topics
Modifying ACT! templates
How do I integrate with ACT?
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Changing the diagnostic settings

Zetadocs PDF records a log of actions and issues which can be useful when troubleshooting a problem with
Technical Support. The log is written to file and to the Windows Application Event Log.

The logfile is written to the Zetadocs PDF directory which is usually located at:

c:\Documents and Settings\<username>\Local Settings\Application Data\Equisys\Zetadocs PDF\Zetadocs PDF.log. 

This log is in plain text format.

The Application Event Log is viewable using the Windows 'Event Viewer' tool.

Log to log file
Zetadocs PDF logs all actions and issues to the Zetadocs PDF.log file by default. You can turn off file logging to
improve performance if required.

Log to Application Event Log
Zetadocs PDF logs to the Application Event Log by default. Debug level messages are never written to the
event log. You can turn off event log logging to improve performance.

Log Level
Decides the detail of information that is logged. 

There are four levels of information that can be stored by Zetadocs PDF:

· Error level messages – are logged when a critical error occurs
· Warning level messages – are logged when a non-fatal error has occurred and the software can continue
· Informational level messages – are logged to indicate information about high-level actions
· Debug level messages – are low-level messages concerning the execution of software which may be

helpful to a developer

When you set the 'Log Level' the following information will be stored:

Level Information stored
Debug Log debug, informational, warning, and error

messages
Informational Log informational, warning and error messages

Warning Log warning and error messages

Error Log error messages only.

The default setting is Warning which captures basic troubleshooting information. While troubleshooting an
issue with Technical Support you may be asked to lower the level to Debug and to recreate the problem in
order to provide more detailed logging information.

OK
There is no need to restart Zetadocs PDF after changing the diagnostic settings – these are applied
immediately when you click OK.



101

© 2008 Equisys plc.  All rights reserved.  All third-party trademarks are acknowledged



102

© 2008 Equisys plc.  All rights reserved.  All third-party trademarks are acknowledged

How to change the licensing settings

The license settings for Zetadocs PDF allow you to set the location your copy of Zetadocs will use to access
licensing information.  

From the Tools drop down menu select Options, the Options dialog box will be displayed.

Ensuring that the Licensing tag is selected the licensing settings will be displayed:

If your Administrator has set up a company license using the Zetadocs configuration program over your
company network, this should be detected by Zetadocs and the Active Directory option will be automatically
selected.   

If your company does not use Active Directory, you can browse to the Network folder where the Administrator
has saved the licensing and configuration settings, allowing your user information to be retrieved.

Select the OK button to finish making your changes. 

Related Topics
Zetadocs PDF licensing
Upgrading from an evaluation system
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How to change the PDF security settings

The PDF Security settings for Zetadocs PDF allow you to specify options for the creation and security of your
PDF document. 

Opening the PDF Security Dialog

Step 1:  From the Tools drop-down menu select Options, the Options dialog box will be displayed.

Ensuring that the PDF Security tab is selected the PDF security settings will be displayed:

Step 2:  Select the Option that you would like to change, and click in the box next to it to change whether it is
turned on or off. A description of the options can be found here:

What Configuration Settings are there?

Select the OK button to finish making your changes. 

Related Topics 
What Configuration Settings are there?
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How to change the embedded font settings

An embedded font is a style of text, that is held within your PDF document.  This means that the PDF
document holds additional information on how that font is to be displayed.

In order to reduce the file size of a PDF, you can choose not to embed fonts that you are confident all
recipients of your PDF will have access to.  

Excluding a font
The Excluded Fonts list enables users to manage whether fonts will be embedded within PDF documents
created by Zetadocs. Usually this list contains common fonts that most systems have. The default settings for
that list are the fonts: 

· Arial 
· Times New Roman 
· Courier 
· Courier New. 

Follow the instructions below should you wish to add extra fonts to the Excluded Fonts list:

Step 1:  From the Tools drop down menu select Options, the Options dialog box will be displayed.

Ensuring that the Fonts tab is selected the Font embedding settings will be displayed:

Step 2:  Choose the font you wish to exclude from PDF embedding, from the Available Fonts list.
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Step 3:  Select the Add button, the Font name will displayed in the Excluded Fonts list.

To include any font that has been excluded, select the desired font with your mouse button, and use the 
Remove button.  The Font name will disappear from the Excluded Fonts list.

The Reset button resets to default settings

Excluding all fonts
If you do not want any fonts to be included within your PDF document, you can uncheck the Embed fonts in
PDF document check-box. Found at the top of the Fonts Options dialog.  This will significantly reduce the size
of your PDF, but will prevent your PDF from being viewed on any system that does not have the fonts you
have used installed.
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How to change the scanning settings

The scanning configuration tab allows you to set up the default scanner to be used by Zetadocs.

Opening the Scanning configuration Dialog

Step 1:  From the Tools drop-down menu select Options, the Options dialog box will be displayed.

Ensuring that the Scanning tab is selected as shown in the screen below:

Step 2:  Select the Option that you would like to change, and click in the box next to it to change whether it is
turned on or off. A description of the options can be found here:

What Configuration Settings are there?

Select the OK button to finish making your changes. 

 



107

© 2008 Equisys plc.  All rights reserved.  All third-party trademarks are acknowledged

How to change the Bates numbering settings

Each page sent using the Zetadocs client can be automatically assigned a page number or stamp which can
appear in a pre-defined location on the page. Often referred to as automatic Electronic Bates numbering, this
technique is commonly used in the legal profession to assign a unique ID to each page to simplify retrieval.  To
apply Bates numbers to Zetadocs documents:

Step 1:  Select Options from the Tools menu in the Zetadocs client.  

Step 2:  Choose the tab entitled “Bates Numbering” as shown in the screen below.

Step 3:  To enable Bates numbering, check the checkbox entitled ‘Use Bates Numbering’.   This will allow you
to specify further options as described below.

Step 4:  Configure the options, such as a fixed prefix, the start number, and a typeface and position where the
stamp should be applied on each page.  

The Zetadocs client keeps a record of the last used Bates number, which increments for each page submitted,
ensuring that each page sent using the Zetadocs client is allocated a unique number.

Related Topics 
What are Bates Numbers 
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How to change the automation settings

Note: Automation is only available if you have purchased an automation licence.

The automation settings allow you to set default Batch submission options and Delivery method options.

Specifying Batch submission options:

Step 1:  Select Options from the Tools menu in the Zetadocs Client.  

Step 2:  Choose the tab entitled “automation” as shown in the screen below. 

Step 3:  Select the Delete batch after sending option in the Batch submission section if you wish to delete
the batch after all documents have been successfully sent.  Otherwise documents will be stored in the
document explorer window after sending. 

Step 4:  When a batch is submitted to the Zetadocs Client, all documents will be sent immediately by the
delivery method specified in the embedded commands. If you wish to preview the batch before it is sent, for
example, to check the attachments or that addresses are correct, then select the Preview batch before
sending option.

Step 5:  Select the Show info messages on startup and shutdown to display messages on startup and
shutdown should there be any batches with unsent items, as shown below: 
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Message displayed on Startup if you have unsent documents:
 

Message displayed on Shutdown if you have any unsent documents:

Step 6:  Select the View email before sending option, if you wish to view emails in Outlook before they are
sent. 

Step 7:  When you have made your changes, click the OK button to action them. 
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Zetadocs PDF configuration

The Zetadocs PDF configuration program is automatically installed as part of your Zetadocs system.  This
program allows you to manage your Zetadocs PDF program across your network, allowing shared folders and
user accounts to be modified.

General configuration
Zetadocs PDF licensing
User management
Shared network folders
Archiving
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General tab

The General tab allows you to specify the location of your settings file 

Storage
This allows you to specify the location you wish your configuration setting to be stored.  

When you first install Zetadocs PDF this value will be set to Use Evaluation License, however if you add a
valid trial or full license, you will need to specify a location to store your license details.  By default, this is
within the Active Directory.  Should you decide not to use the Active Directory, click on the ellipse "..." to
browse to another network folder.  The network folder should be accessible to all users configured to use the
system.



112

© 2008 Equisys plc.  All rights reserved.  All third-party trademarks are acknowledged

Zetadocs PDF licensing

In order to activate your trial or full Zetadocs PDF system, you will be required to enter your starter license
number and any add-on license numbers using the Zetadocs PDF licensing screen.

Should Zetadocs PDF  be started without entering a valid license number, you will start in evaluation mode,
which will allow you to trial the product for a month.

To add a starter license number
Step 1: Select the Zetadocs PDF licensing and Registration tab within the Zetadocs PDF Configuration
Program.
Step 2: Select the Change button.

This will start up the Enter a Starter system license dialogue

Step 3: Type in your license number.
Step 4: Select OK to process your license number.   

Your license number will appear in the license summary box allowing you to see what features are enabled and
how many users you are licensed to use.

To add an add-on license number 
Step 1: Select the Zetadocs PDF licensing and Registration tab within the Zetadocs PDF Configuration
Program.
Step 2: Select the Add button.

This will start up the Enter an add-on license dialogue

Step 3: Type in your license number.
Step 4: Select OK to process your license number.   

Your license number will appear in the license summary box allowing you to see what features are enabled and
how many users you are licensed to use.

Note: You must register your Zetadocs PDF system within 30 days, or the system will cease to function.  Click
here for details on how to register your system.
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Upgrading from an evaluation system

In order to upgrade your Zetadocs PDF evaluation system to a trial or full Zetadocs PDF version, follow these
steps:

Within the Zetadocs PDF Configuration Program
Step 1: Follow the steps described here for entering your Zetadocs licence number and add-on licence
numbers. 

Note: After you enter you the Zetadocs licence you will be prompted to register, skip this step until you have
entered all your add-on licenses to avoid multiple registrations.

Step 2: Once you have successfully entered your all your licence details you will be required to re-register the
system. Follow the steps detailed here on registering Zetadocs PDF.

Note: That once you have successfully registered your trial or full licence Zetadocs PDF system that the
configuration information storage location will default to Active Directory if it is present on the network. This
storage location is specified on the General screen in the Zetadocs Configuration program. For information on
using this effectively see the help here.

Step 3: Now proceed to configure the rest of your Zetadocs PDF system including adding users, archiving and
setting up shared network folders. Then click Save and Exit.

Within the Zetadocs PDF Client 
When you now start the Zetadocs PDF Client it will still be pointing to your Evaluation licence configuration. 

To begin using your new entered licence information: 

Step 1: Launch the Zetadocs PDF Client.
Step 2: Go to Tools -> Options. 
Step 3: On the Licensing tab select the configuration location you specified on the General tab of the
Zetadocs PDF Configuration program earlier and click OK. 

You will now be required to restart the Zetadocs PDF Client to begin using your full licence.
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Requesting a trial license

To evaluate a multiple network user system or any of the Zetadocs PDF Add-on features you require a Trial
licence. To obtain a trial licence please contact the Zetafax distributor for your country or:

EQUISYS plc - United Kingdom
Phone: 020 7203 4000 (Intl +44 20 7203 4000)
Fax: 020 7203 4005 (Intl +44 20 7203 4005)
Sales email: sales@equisys.com
Support email: support@equisys.com
http://www.equisys.com

EQUISYS Inc - USA and Canada
Phone: (770) 772 7201
Fax: (770) 442 5789
Sales mail: sales@usa.equisys.com
Support email: support@usa.equisys.com
http://www.equisys.com

mailto:sales@equisys.com
mailto:support@equisys.com
http://www.equisys.com
mailto:sales@usa.equisys.com
mailto:support@usa.equisys.com
http://www.equisys.com
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Zetadocs PDF Registration

Zetadocs PDF Registration requires a valid web browser and internet connection. For information on installing
from a different computer which is web enabled click here.

Note: Every time you enter a new licence number, you will need to re-register to keep your product activated.
Therefore should you have any add-on licenses, add these before completing the registration process.

Requesting a registration code

Step 1: On the Licensing and Registration screen of the Zetadocs PDF Configuration program, select
the Register button to set your company name as shown in the screen below:

Step 2: Enter your company name and press OK. 

This will open the Zetadocs PDF Online Registration Page in your web browser and open the Zetadocs
Configuration program on the Licensing and Registration tab. Should you have difficulty with this please
see Registering from a different PC.

Step 3: Fill in the remaining fields on the online registration page and hit Register:
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You will receive an email with your registration code within a few minutes. 
 
Step 4: Once you have received your registration code, start up the Zetadocs PDF Configuration program,
and enter the Licensing and Registration screen: 
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Step 5: Press the Set button and the Registration code dialog will be displayed: 

Step 6: In this dialog enter the registration code that was sent to you at the email address you specified in
the registration form. 
Step 7: Press the OK button to register your system. 

If the registration is successful, the configuration will be saved automatically, the following message will be
displayed:
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Registering your Evaluation version

For an evaluation installation you are required to register Zetadocs PDF to begin using the application. Until
you have registered, starting either the Zetadocs Client or Zetadocs Configuration program will result in being
prompted for your company name to begin registration. 

Step 1: Enter your company name and press OK. This will open the Zetadocs PDF Online Registration
Page in your web browser and open the Zetadocs Configuration program on the “Licensing and Registration”
tab. Should you have difficulty with this please see Registering from a different PC.

Step 2: Fill in the remaining fields on the online registration page and hit Register:
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You will receive an email with your registration code within a few minutes. 
 
Step 3: Once you have received your registration code, start up the Zetadocs PDF configuration program, and
enter the Licensing and Registration screen: 

Step 4: Press the Set button and the Registration code dialog will be displayed: 

Step 5: In this dialog enter the registration code that was sent to you at the email address you specified in
the registration form. 
Step 6: Press the OK button to register your system. 

If the registration is successful, the configuration will be saved automatically, the following message will be
displayed:
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Registering from a different PC

In the event of your Zetadocs PDF system being installed on a non web enabled PC you be required to perform
your registration by manually visiting our online registration web page.

To do this please follow these steps:

Step 1: On your web enabled PC open a web browser and go to

http://www.equisys.com/products/OnlineRegistration.html.

Step 2: Click on the link which is relevant for your registration. For example, if you are registering an

Evaluation copy of Zetadocs, click Zetadocs PDF Evaluation Registration.

Step 3: Next fill in the Online Registration form, make sure to fill all the required fields including Starter

licence and add-on licenses where prompted.

Step 4: Ensure that you carefully enter your Company name as this cannot be changed without

re-registering and must be entered exactly as submitted here in the Zetadocs Configuration

program on the Licensing and Registration tab.

Step 5: Click Submit.

Step 6: You will be emailed you registration confirmation email within a few minutes. This will include the

registration code.

Step 7: Now on your Zetadocs PDF installation PC start the Zetadocs PDF Configuration program and go

to the Licensing and Registration tab.

Step 8: Enter you Starter licence and add-on licenses as described here. Note: You will be prompted to

register your changes after each license you add. Cancel all of these. 

Step 9: Once you have entered all licenses, enter your company name exactly as it is in the registration email

you have received, in the Company Name text box. 

Step 10: Click OK. 

Zetadocs will now attempt to connect to the online registration page which should fail.  

Step 11: Click the Set button for Registration Code. 

Step 12: On the displayed dialog enter the registration code exactly as on the registration email you received

and click OK.

You should now have successfully registered your Zetadocs PDF system. 

http://www.equisys.com/products/OnlineRegistration.html
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User management

The user management option allows you to specify which of the users on your network are authorized to use
Zetadocs PDF.  

On the right hand side of this page, you will find a record of how many user licenses have been purchased,
and how many users are using those licenses.  At any time, you can increase the number of user licenses by
purchasing an additional user license.  

To activate a single user from a domain

Step 1: Select Add from Domain.
Step 2: Using the Locations option, navigate to your local domain. By default the dialog will search your
entire user directory.
Step 3: Type in the user name you wish to activate for example "Sam Smith" within the Object names text
box:

Step 4:  Check the name using the Check Names option.

If the user name is correct, the name will be displayed along with the users email address in the Object
names text box.  If it is incorrect, a further dialog will be displayed that allows you to modify the details you
have entered.

Step 5:  Press OK and your user will be added.

To activate Multiple users from a domain
Step 1: Select Add from Domain. 
Step 2: Select the Advanced button.
Step 3: Using the Locations option, navigate to your domain.
Step 4: Select the Find Now button to display all users, or use the Common Queries search to search for
specific users.
Step 5: Select the users you wish to activate from the displayed list (for multiple selections hold down the Ctrl
key.
Step 6: Press OK to return to the Select Users dialog.
Step 7: Press OK to add these users.
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To activate users from a workgroup
Step 1: Select Add from Workgroup.

The User Management screen will change to include a new Add from Workgroup text box.  

Step 2: Add the user names you want to activate into the Add from Workgroup text box.

You can add workgroup users by entering the username they use to logon to a machine, for example "jjones".
You can also enter the full workgroup username which includes the name of their local machine, for example
"SUNBIRD\jjones" where SUNBIRD is the name of jjones' machine.

If you wish to add several users, separate each user name with a ',', for example:

ssmith, Support\halhunter, jjones@sales

Step 3: Select OK to add the specified users.

To deactivate a user

Step 1: Find the user name you no longer wish to have Zetadocs PDF access rights displayed on the User
Management screen.
Step 2: Use the Remove button to deactivate this user's Zetadocs PDF account.

Having completed your user management tasks, select the Apply option to save your changes.
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Shared network folders

Shared network folders, allow you to add folders that your Zetadocs users can access.  This allows you to set
up different folders over your network that different users can access.  As user's will view your description of
the shared folder, make sure that your name is descriptive enough that other user's understand which folder
to use.

For example:

Corporate - Company letterheads and General attachments likely to be used by all departments.
Sales - Terms and conditions, product brochures and price lists.

To create a new shared network folder

Step 1: Browse to your network folder.
Step 2: Right click your mouse and select sharing and security from the menu that appears.
Step 3: Select the Sharing tab: 

Step 4: Select the Share this folder option.
Step 5: Ensure that the Zetadocs users are able to access the folder by selecting the Permissions option.
This will display the share permissions dialogue:
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Step 5: If necessary add your Zetadocs users and click on OK save your changes.

To add a shared network folder to Zetadocs
Step 1: Select the shared network folder option.
Step 2: Select the Add button.

A new dialogue window will appear that prompts you for the destination of your folder and the name you wish
to use to describe it.

Step 3: If you know the location of your folder, you can type or paste it into the Folder text box.  If you are
unsure, then use the "..." button next to this text box to browse to your folder location.
Step 4: Add a name for your folder.
Step 5: Select Save to save your shared network folder.

To edit a shared network folder
If for any reason you wish to change the name you have given your shared network folder, this can be done
using the edit function:

Step 1: Select the shared network file you wish to edit.
Step 2: Select the Edit button.

A new dialogue window will appear that shows you the destination of your folder and the name you have used
to describe it.

Step 3: Make any changes you need to make.
Step 4: Select Save to save your shared network folder.
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To remove a shared network folder
Step 1: Select the shared network file you wish to edit.
Step 2: Select the Remove button.

The shared network folder will no longer be displayed in Zetadocs PDF.
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Archiving

The archive and retrieval system allows for all sent documents to be placed in an archive and for this to be
searchable i.e. search on document metadata. The system administrator can configure and switch on or off the
archive through the Zetadocs PDF configuration program. When the archive is switched on, the pdf files sent
are archived along with an associated metadata file, this allows information such as the recipient of the PDF,
and the subject line to be searched for. The user is able to view the archive from the accessories window
within the Zetadocs PDF program.

Configuring the archive
From within the Zetadocs PDF configuration program you can set up the archive options for all users. The
options are grouped together under the Archive tab. The following options are available:

Archive Documents - a check box that enables the archive feature.
Archive Root Folder - a combo box that allows you to choose the network folder to use as the root folder for
the archive. If you have not already done so, you must create a network shared folder and setup a descriptive
name for this in the Shared Network Folders tab first. The suggested name for this is Archive. All users
must have access to this folder and have the ability to create subfolders.

How do you want the archive subfolders to be created? - allows you to choose the method of storage:

· Daily archive folders (recommended) - PDF documents are stored in folders that are dated  with
the following naming convention: YYMMDD, allowing you to quickly find your sent PDFs. 

· Single folder - all PDFs are stored in a single folder, allowing them to be accessed by third party
archiving applications.  When this option is selected, the additional checkbox: Save Metadata as
CSV is also enabled, this checkbox allows you to save the metadata as a CSV file as well as in the
default XML file format.

Related Topics 
How to re-submit a sent PDF
How to archive your sent documents
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Tutorials

This section is designed to help you learn how Zetadocs can be applied in real life situations.  Throughout
these tutorials, there are references to documents and accessory files.  All documents that are referred to
can be found in the following location:

C:\Program Files\Zetadocs PDF\Samples

and can be accessed using the short cut in the start menu.

All Accessories that are referred to are downloaded into you default Zetadocs directory.

If either of these components is not present on your system, try reinstalling the software.

Tutorial 1: Getting started 
Tutorial 2: Creating stationery
Tutorial 3: Creating document attachments
Tutorial 4: Creating PDF attachments
Tutorial 5: Creating document templates
Tutorial 6: Mail merge and Zetadocs
Tutorial 7: Sending quotations from ACT!
Tutorial 8: Archiving sent quotations to ACT! contact history
Tutorial 9: Sending personalized marketing mail shots from ACT!
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Getting started 

Zetadocs PDF allows you to create a PDF document that you can send using Microsoft Outlook from almost any
Windows application.  This tutorial will introduce you to the basic features of Zetadocs PDF.  Using some of the
documents created on installation, you will:

a) Print a document from Word.
b) Apply stationery and an attachment.
c) Send the document as a PDF to a recipient in your Outlook address book.

Please follow the instructions below:

1) Open any document in Microsoft Word.  On installation, Zetadocs creates shortcut buttons within Microsoft
Office applications to make it simpler to use.  If you are using Office 2007, click the Office Button and
select “Send”. Select “Email using Zetadocs PDF” as in the screen below.  Alternatively, you can select Print
and choose the Zetadocs printer. For office 2003 users, click "File | Print" and select the Zetadocs PDF
printer.  Zetadocs PDF will run and you will see your document in the reading pane.
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NB: For Office 2003 users, a toolbar button is installed in your standard toolbar.  Click on the "Zetadocs
PDF" button.  

2) On the Zetadocs PDF toolbar, click "Accessories".  The Accessories window opens.  

3) Select the "Zetadocs PDF" folder and "Stationery" from the "Type" drop down list.  Highlight the stationery
entitled "WM Stationery". A thumbnail preview appears.  Click the "Apply" button or drag the stationery to
your document in the Document Explorer window.  The stationery is merged with your document.

4) From the Accessories window, select "Attachment" from the "Type" drop down list, in the Zetadocs PDF
folder.  Highlight the attachment entitled "WM attachment".  Click the "Apply" button or drag the
attachment to your document in the Document Explorer window.  The attachment will be added to your
document.  The image in the thumbnail view is also updated, showing all pages of your document.  You can
click on any of these pages to view them in the reading pane.
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5) To address the document, select the document name which appears at the "root" of the document tree in
the document explorer window.  The display in the reading pane changes to an email form, as in the screen
shot below.  Write and address your email using the form as you would with Outlook.  
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6) On the Zetadocs PDF toolbar, click "Send".  An Outlook email form will pop up that contains your message
and your PDF attachment.

The tutorial is complete.  
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Creating Stationery 

Using this tutorial you will be shown how to create stationery that you can then use with Zetadocs to
customize your documents.  Using some of the documents created on installation we will:

a)  Add images to a Word document

b)  Print your stationery from Word

c)  Save your stationery

d)  Apply your stationery to a standard document

Please follow the instructions below:

1)  Open Microsoft Office Word and create a new document

2)  Add the header logo to your document using the Insert > Picture > From File. This will allow

you to insert any image file that is compatible with Microsoft Office suite. For the purposes of this tutorial we

will the sample logo found in the Zetadocs PDF folder Large Logo.jpeg

3)  Place the logo at the top right of your document window using the right justification option and

adjusting the margins.

4)  Add the footer logo named bottom logo.jpeg at the bottom of the document, and again adjust

the placing until you feel it is in  the correct position.

5)  Print your document to the Zetadocs PDF printer.

6)  Select the document that you have just printed.

7)  Use the reading pane to check the layout of your stationery

8)  If you are happy with the look of your stationery, then the stationery can be saved using the Save

as Stationery option found in the File menu.

9)  This will open the Save As menu window, and allow you to choose a file name for your

stationery. 

10) Select the Save option to save your stationery

This stationery can now be applied to any documents printed to Zetadocs PDF. To test your stationery simply

apply it to the sample document.      
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Creating document attachments 

Using this tutorial you will be shown how to create document attachments that you can then use with Zetadocs
to customize your documents.  Using some of the documents created on installation we will:

a)  Print your attachment from Word.

b)  Customize your attachment.

c)  Save your attachment.

d)  Add your attachment to a standard document.

Please follow the instructions below:

1)  Open the sample document: Sample Attachment.doc in Word.

2)  Print the document to the Zetadocs PDF printer.

3)  Select the document that you have just printed.

4)  Use the reading pane to check the layout of your attachment.

5)  Add any stationery you wish to have present within your attachment.

6)  If you are happy with the look of your attachment, then the attachment can be saved using the

Save as Attachment option found in the File menu.

7)  This will open the Save As menu window, and allow you to choose a file name for your

attachment. 

8)  Select the Save option to save your attachment. 

This attachment can now be added to any documents printed to Zetadocs PDF. To test your attachment simply

add it to the sample document sample letter.doc.  
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Creating a PDF document

Using this tutorial you will be shown how to create a PDF document that you can then use with Zetadocs to be
included as a document attachment.  Using some of the documents created on installation we will:

a)  Print your document from Word.

b)  Customize your document.

c)  Save your PDF document.

d)  Add your PDF document attachment to a standard document.

Please follow the instructions below:
1)  Open the sample document: attachment.doc in Word.

2)  Print the document to the Zetadocs PDF printer.

3)  Select the document that you have just printed.

4)  Use the reading pane to check the layout of your attachment.

5)  Add any stationery and attachments you wish to have present within your PDF document.

6)  If you are happy with the look of your PDF document then the PDF document can be saved using

the Save as PDF document option found in the File menu.

7)  This will open the Save As menu window, and allow you to choose a file name for your PDF

document. 

8)  Select the Save option to save your PDF document. 

This PDF document can now be added as an attachment to any documents printed to Zetadocs PDF. To test
your PDF document attachment simply add it to the sample document.  
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Creating document templates

Using this tutorial you will create a document template that you can later use to help you quickly build
documents that you create routinely.  Document templates within Zetadocs allow you to specify a set of rules,
such as add company stationery, and conditions of sale, and when used, ensure that the correct information is
always applied to your document.

Using document templates allows you to speed up the document production process while offering peace of
mind by ensuring that your documents maintain a consistent look and feel. 

Using some of the documents created during installation we use the Document Template Wizard to: 

a) Add an attachment. 
b) Add stationery.
c) Apply messaging options to a document template.  
d) Save your document template.  
e) Apply your new template to a new document.  

Please follow the instructions below: 
1) Open Zetadocs PDF  and select the Tools > Create Document Template... option.  
2) The Document Template Wizard will start. Select the Next option to continue.    
3) On the next screen, you can specify attachments that you wish to be added to your documents.  Available

attachments are displayed in the top-left box.  You can select an attachment by highlighting it.  Select the
attachment entitled "WM Attachment".  A preview appears as a thumbnail.  To add this brochure as an
attachment, click on the Add button.  The WM Attachment will be listed in the Selected Attachment box as
shown below.  You can add more attachments if you have them available. 

Zetadocs PDF allows you to specify the order in which the attachments appear in your document relative
to the Original Document that you printed to the Zetadocs PDF printer.  Highlight the attachment if you
wish to change the order and click Move up or Move down.

Click on Next > to continue.
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4) You will now be asked if you wish to specify any stationery. You can leave this blank, or select stationery

by highlighting it.  Select the stationery entitled "WM Stationery".  A preview of this stationery appears as a
thumbnail.  To add this stationery, click on the Add button.  The WM Stationery you selected will be listed
in the Selected Stationery box as shown below.  Click on the Next button when you are ready to proceed.  
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5) The email properties screen allows you to specify default message options for your document template.  It

is possible to specify mail recipients, a subject field and a message body.  Specifying the message body can
speed up the document production process.  By specifying mail recipients, Zetadocs PDF can ensure that
sales quotations are always copied to the sales manager, or reports can be dispatched quickly and
effortlessly, looking great every time.

Enter your subject and message body and select a recipient either by entering their SMTP email address or
clicking To: and selecting a recipient from your Outlook address book.

When you are ready to proceed, click Next >.

6) The summary screen is the final screen in the Wizard and lists the settings you have chosen. You can select
a name for your document template e.g. Sales Quotation.  You can save your template locally for your own
use or in a shared network location so that other network users can access it.

Note: if saving a template to a shared location on the network, you must ensure that the PC where you
store the template has appropriate access to any stationery or attachments you have used.
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Click Finish when you are ready to proceed.

Using document templates 

Like stationery and attachments, document templates are accessible using the accessories Window, or using
embedded commands.  

1) Open the document entitled "Sample Letter.doc" using Microsoft Word.  The letter is located in the following
folder:

C:\Program Files\Zetadocs PDF\Samples\Sample Letter.doc

2) Print the document to the Zetadocs PDF printer.  The Zetadocs PDF software will display your document.

3) Click on the Accessories button, or choose View | Accessories Window.  Selected the folder where you
saved your template, and select Templates from the Type drop down.

Your template entitled "Sales quotation" will be visible.  Highlight it and click Apply.  The stationery and any
attachments will automatically be added to your document.  If you included any email sending options such as
a message body, or subject line, it will be visible as shown in the screen below.
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4) Click Send to deliver the document.
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Mail Merge and Zetadocs

Using this tutorial you will be shown how to create a mailmerge template that you can then use with Zetadocs
to send out a personalised PDF to a group of your clients.  Using some of the documents created on
installation we will:

a)   Create a Mail Merge template
b)   Merge the document 
c)   Send the document to a group of users

 
1. Browse to Program Files/Zetadocs PDF/Samples on your C drive and open Sample1.doc.

Ensure the Mail Merge Toolbar is shown (right click your mouse in the toolbar area and select the Mail Merge
option).

For Word 2007 users, select the Mailings tab.

2. Select a data source (icon looks like a table). (For Word 2007 users, Select Recipients > Use Existing
List..)

3. Browse to Files/Zetadocs PDF/Samples on your C drive,  open MailMerge.xls and select sheet1.

4. Add the following to the top of your document: 

%%[startdocument]
%%[email: XXXXXXX]
%%[subject: Support contracts due for renewal]
%%[excludepage]
%%[startbodytext]

5. Replace the XXXXXXX with the mail merge field for email address using the insert merge fields option. 

6. Add the following at the bottom of the first page: 

%%[endbodytext]

This will let Zetadocs know that the first page is designed to be part of the email body.

7. Open Zetadocs, and select any stationery you wish to add from the accessories pane. 

8. Right click your mouse, and select Copy Automation Command from the drop down menu. 

9. Return to Word, and paste the command between the subject and the exclude page lines: 

For Example 

%%[subject: Support contracts due for renewal]
%%[stationery:C:\Documents and Settings\eboal\Local Settings\Application
Data\Equisys\Zetadocs PDF\Equisys Letterhead A4.zds]
%%[excludepage] 

10. Merge your document using Microsoft Office Word's Mail Merge feature: 

For Word 2007 users, click Finish & Merge > Edit individual Documents or pressing ALT+Shift+N
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11. Print your new document to Zetadocs to send it.
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Sending quotations from ACT!

Using this tutorial you will be shown how to modify an ACT! template that can be used to send Quotations to
ACT! contacts as PDF files.  

To modify your quotation template, please follow the instructions below:
1. Open the ACT! application.

2. Select Write | Edit Template from ACT! Menu bar.

3. Select the template called Quote.adt from the list as shown in the screen shot below. Doing so
will launch the Template within Word.

4. On a new line in the Quote template, insert the following command:

%%[email:<E-mail>]

The Zetadocs commands can be inserted simply using the Word add in which is visible in the
toolbar as shown in the screenshot below.
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The <E-mail> field is the ACT! field that corresponds to the email address of the recipient. To
insert these fields, open the ACT! Mail Merge Fields dialogue box, by selecting Show Field List
from the ACT! menu.  Select E-mail from the list and click Insert. Without these fields, it would
be necessary to manually enter the email address for each recipient.  

5. Open Zetadocs PDF and open the accessories Window by selecting View | Accessories Window
.  Select Stationery from the Type drop down box as in the diagram below, and choose the
stationery you wish to merge this document to.

6. With the stationery you wish to use highlighted, right-click and select Copy Automation
Command as in the screen below.

A dialog will appear stating that the automation command has been copied to the clipboard. 

7. Return to the ACT! template in Word, and Paste from the Edit menu to paste the command into
the document adjacent to the other commands.
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Your document should now look similar to the document shown in the screen below.

You can repeat this process with other accessories, for example if you wanted to add attachments
such as a product brochure or price list to your email or use a pre-defined document template,
you can copy and paste the command to the Quotation document.

7. When you have added all of the accessories you wish to add to your document, highlight the
Zetadocs fields i.e. all fields beginning %%[and select Format from the menu bar.  Select Font
and from the Font Color drop down list and select the color white. This will make the fields
invisible in the final document.

8. Once the Embedded Addressing commands have been inserted, save the document.

9. Zetadocs PDF Embedded Addressing offers much greater functionality than described above, such
as customizable text in the body of the email. For further information, please refer to the online
help within Zetadocs.

How to send quotations from within ACT! as a PDF by email:
Follow these instructions to create and send a quotation as a PDF file direct from ACT!

1. Quotations can be generated from opportunities you have created within ACT!  To view
opportunities or to create a new one, select Opportunity List from the View menu.  

2. To create a new opportunity, click the new opportunity button  (second from the left in the
toolbar).

3. Complete the relevant information in the Opportunity dialog as shown in the screen below. When
you are ready to generate the quote, click the Quote button.  This will launch the Quote
Template you edited earlier within Word. All ACT! merge fields will have already been filled with
the relevant details of the selected contact.
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4. Print the Quotation to the Zetadocs PDF Printer.  If you have selected Preview document
before sending in the Tools | Options dialog within Zetadocs, it will allow you to preview your
Quotation before releasing it as shown in the screen below.  Other attachments, such as PDF
documents can be added to your letter at this point.  When you are ready to send the document,
select Send from the Zetadocs PDF toolbar.

Related Topics
Archiving Sent Quotations to ACT! contact history
Sending personalized marketing mailshots from ACT!
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Archiving sent quotations to ACT! contacts

Using this tutorial you will be shown how to modify an ACT! template that can be used to archive all
Quotations sent using Zetadocs PDF automatically in the History tab against the ACT! customer record.  

To modify your quotation template, please follow the instructions below:
1. Open the ACT! application.

2. Select Write | Edit Template from ACT! Menu bar.

3. Select the template called Quote.adt from the list as shown in the screen shot below. Doing so
will launch the Template within Word.

4. Add the Add contact history embedded command by selecting ACT! | Add a contact history
from the menu on the Zetadocs PDF toolbar in Word. 

This will automatically add the following command:
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%%[ActContactHistory: <MY:Company>, <Contact>, <Email>]

Where MY:Company, Contact, and Email are ACT! fields representing your company
name, the name of the contact that the letter is being sent to, and the email address of the contact
that the letter is being sent to respectively.

5. As an option you can select which information is stored in the contact history using the
%%[ActHistoryOptions] command. Further information can be found in the Modifying ACT!
Templates section.

6. Save your changes to the template and return to ACT!  Each time a Quote is sent using Zetadocs
PDF using the Quote template you modified, a copy of the quote will be archived against the
history of the contact. This will happen just after the email has been submitted.

Related Topics
Sending Quotations from ACT!
Sending personalized marketing mailshots from ACT!
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Send personalized marketing mail shots from ACT!

Using this tutorial you will be shown how to modify an ACT! template that can be used to send a multi-page
mail merged document to multiple ACT! contacts by email as personalized PDF files.  

Included within ACT! are some example templates used for direct marketing purposes.  This tutorial will use
the "Initial communication – Direct Marketing Letter" template supplied with ACT! 2005 and 2006.  

To modify your direct marketing template, please follow the instructions below:
1. Open the ACT! application.

2. Select ‘Write | Edit Template’ from ACT! Menu bar.

3. Select a template to edit.  In this example, we will open the template called ‘Initial
communication – Direct Marketing Letter.adt’ from the list. Doing so will launch the Template
within Word.

4. At the very top of the Template insert the following commands:

%%[startdocument]
%%[subject: <Company>] - take advantage of this free needs analysis]
%%[email:<E-mail>]
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The Zetadocs commands can be inserted simply using the Word add in which is visible in the
toolbar as shown in the screenshot below.

The <Company> and <E-mail> fields are the ACT! fields that correspond to the company name
and email address of the recipient. To insert these fields, open the ACT! Mail Merge Fields
dialogue box, by selecting ‘Show Field List’ from the ‘ACT!’ menu.  Select ‘Company’ from the list
and click ‘Insert’. Repeat the same process for inserting the Email address field.  Without these
fields, it would be necessary to manually enter the company name and email address for each
recipient.  Your document should look similar to the document shown in the screen below.
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5. Open Zetadocs PDF and open the accessories Window by selecting ‘View’ | ‘Accessories Window’.
Select ‘Stationery’ from the ‘Type’ drop down box as in the diagram below, and choose the
stationery you wish to merge this document to.

6. With the stationery you wish to use highlighted, right-click and select ‘Copy Automation
Command’ as in the screen below.

A dialog will appear confirming that the automation command has been copied to the Windows
clipboard.

7. Return to Microsoft Word processor, and select ‘Paste’ from the ‘Edit’ menu to paste the
command into the document adjacent to the other commands.

You can repeat this process with other accessories, for example if you wanted to add attachments
such as a product brochure or price list to your email or use a pre-defined document template,
you can copy and paste the command to the Quotation document.

8. When you have added all of the accessories you wish to add to your document, highlight the
Zetadocs fields i.e. all fields beginning ‘%%[‘and select ‘Format’ from the menu bar.  Select ‘Font’
and from the ‘Font Color’ drop down list and select the color white. This will make the fields
invisible in the final document.

9. Once the Embedded Addressing commands have been inserted, save the document.
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Zetadocs PDF Embedded Addressing offers much greater functionality than described above, such
as customizable text in the body of the email. For further information, please refer to the online
help within Zetadocs.

How to send a personalized marketing email shot from within ACT! as a PDF by email:
Follow these instructions to create and send a personalized email shot to multiple recipients as a PDF file direct
from ACT!

1. Select Write | Mail Merge from the ACT! toolbar.

2. Select ‘Word Processor’ from the ‘Select Output’ dialog (stage 2 of the Wizard).

3. Select the Template you created from the available list e.g. ‘Initial communication – Direct
Marketing Letter.adt’ 

4. From the ‘Select Contact’ dialog select the recipients you wish to send the document to – either
current lookup, current contact, all contacts, selected group or selected company.

5. Click ‘Finish’. The special offer letter will be merged with the customer contact information for
your selected contacts and presented in a single document. This lets you preview the documents
before sending them.  The Zetadocs PDF embedded commands will be included in the document,
although they will be invisible as they are white. 

6. Print the Word document to the Zetadocs PDF printer.  If you have selected ‘Preview document
before sending’ in the ‘Tools’ | ‘Options’ dialog, Zetadocs PDF will preview all of the documents
before releasing them to be sent.  

7. Choose ‘Send All’ from the Zetadocs PDF toolbar to distribute your documents via Outlook.

Related Topics
Sending Quotations from ACT!
Archiving Sent Quotations to ACT! contact history
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Sending documents as a batch

Note: Batch automation is only available if you have purchased an automation licence.

Using this tutorial you will be shown how to create a mailmerge template that you can then use with Zetadocs
to send out a personalised PDF to a group of your clients.  Using some of the documents created on
installation we will:

a)   Create a Mail Merge template
b)   Merge the document 
c)   Send the documents as a batch

 
1. Browse to Program Files/Zetadocs PDF/Samples on your C drive and open Sample1.doc.

Select the Mailings tab.

2. Select a data source (Select Recipients > Use Existing List..). 

3. Browse to Program Files/Zetadocs pdf/Samples/MailMerge.xls and select sheet1.

4. Add the following to the top of your document: 

%%[startdocument]
%%[name:XXXXXXX]
%%[organization:XXXXXXX]
%%[email: XXXXXXX]
%%[fax:XXXXXXX]
%%[deliveryoption:Email,Fax]
%%[batchhold:true]
%%[subject: Support contracts due for renewal]
%%[excludepage]
%%[startbodytext]

5. Replace the XXXXXXX with the appropriate mail merge field using Insert Merge Field on the ribbon.

6. Add the following at the bottom of the first page: 

%%[endbodytext]

This will let Zetadocs know that the first page is designed to be part of the email body.

For more information on the embedded commands, please click here.

7. If you want to add stationery to your document, follow these instructions, otherwise go to step 10. Open
Zetadocs, and select any stationery you wish to add from the accessories pane. 

8. Right click your mouse, and select Copy Automation Command from the drop down menu. 
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9. Return to Word, and paste the command between the subject and the exclude page lines: 

For Example 

%%[subject: Support contracts due for renewal]
%%[stationery:C:\Documents and Settings\eboal\Local Settings\Application
Data\Equisys\Zetadocs PDF\Equisys Letterhead A4.zds]
%%[excludepage] 

10. Merge your document by clicking Finish & Merge > Edit individual Documents or pressing
ALT+Shift+N.

11. Print your new document to Zetadocs to send it.

Related Topics
Send documents as a batch
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What is a document?

A document in this context is regarded as a Zetadocs document, which is composed of several other
documents types merged together to form one document that can have stationery and templates applied to it. 
It also has associated delivery information for email, fax and print. The document is submitted to the Zetadocs
Client as one single PDF document and sent to the relevant applications as per the delivery options specified in
the embedded commands.

Related Topics
Send documents as a batch
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What are document templates? 

Document templates are combinations of attachments and stationery that can be created and stored. These
can then be used to ensure that documents that are sent out on a regular basis have all required information
and can be created quickly. 
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What is an attachment?

Any file that you use on a regular basis can be stored as an attachment file for ease of use. Just like
stationery, these files can be attached to any spooled document prior to sending quickly and easily using the
Accessories tool. 
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What is a valid attachment type?

Although you can continue to add any attachments that you need to your messages, only attachments from
Office products, such as Word and Excel will be recognized by the Zetadocs PDF and therefore be converted
to PDF.
 
If you choose to zip your attachments after conversion, all attachments including those not converted will be
added to the zip file.
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What is a section?

When you combine files files from different applications, for example, Word and Excel, the different files are
referred to as sections once they are combined and previewed in the thumbnail view in the Zetadocs Client.
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What is a batch?

Note: Batch automation is only available if you have purchased an automation licence.

A batch is a set of documents submitted at the same time to the Zetadocs Client which is processed as a
group. You can take actions on a batch, for example, send a batch or delete a batch. You can also take action
on individual or selected documents in the batch, for example you can send, delete or put a document on hold.
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What are Bates numbers?

Bates numbering or Bates stamping is used within the legal profession to sequentially assign a unique
number/reference (sometimes including date and time) to each page of a document pertaining to a legal case. 
The term “Bates numbering” is used mostly in the US.  In the UK documents pertaining to a case are
commonly referred to as “court bundles”.  The term “Bates Number" comes from the Bates Manufacturing Co.
which was incorporated on September 13, 1890 in New York State. The Bates Manufacturing Co. manufactured
and sold automatic hand-held numbering machines. 

Manual Bates stamping used a self inking stamp that incremented a sequential number each time it was
pressed down on a document.  Zetadocs offers automatic Electronic Bates numbering enabling users to:

· Specify a prefix for the unique Bates number e.g. Equisys/2006
· Specify an integer to start numbering e.g. 00000001
· Choose a typeface for the stamp
· Choose a position on the page to apply the stamp

Bates Numbers can be automatically applied to all PDFs produced via the Save or Send function.  
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What are PDF files?  

Adobe's Portable Document Format (PDF) is a translation format used primarily for distributing files across a
network, or on a web site. Files with a .pdf extension have been created in another application and then
translated into .pdf files so they can be viewed by anyone -- regardless of platform.

PDF files can be stored and used as an attachment type. Attachments that are stored as PDF files can be
added to your document in 2 ways, either as a stand alone document or as part of the spooled document.
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What is an embedded font? 

An embedded font is a style of text, that is held within your PDF document.  This means that the PDF
document holds additional information on how that font is to be displayed.

In order to reduce the file size of a PDF, you can choose not to embed fonts that you are confident all
recipients of your PDF will have access to.  
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What is electronic stationery? 

Electronic stationery is the Zetadocs PDF equivalent of using pre-printed letterheads. Electronic stationery can
be created quickly and easily using any windows based program, and can then be applied to entire documents
or individual pages as required. 
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What are the delivery methods? 

Delivery methods contain the information required to send the document to the recipient. These can be
specified within Zetadocs PDF, via embedded commands or left blank, and filled in with your email editor. They
include:

To...
The email address of the person or persons that you wish to send your message to can be filled in here 

Cc...
The email address of any persons you wish to send a carbon copy of your message can be filled in here 

Bcc...
The email address of any persons you wish to send a blind carbon copy of your message can be filled in here 

Fax...
The information for any fax recipients can be added here

Printer...
The printer name can be selected by clicking the Printer... button to print a hard copy of your document

Options...
The faxing options can be set here

Subject:
A short description of your message can be filled in here 

Message Body 
Any further information about your message can be entered here 
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What is the accessories option for? 

The accessories option allows you to customize your documents before sending them. There are four different
types of accessory you can add to your document:

Stationery
Electronic stationery can be added to your document, allowing you to send professional looking documents
quickly and simply. As there is no limit to the number of stationery items that you can store, you can change
the stationery you use to include different company logos and different contact details depending on the type
of document you are sending. 

Attachments
To speed up the creation of a final document ready to be sent, you can save attachments that you need to
send regularly within Zetadocs. Any number of attachments can be added to each document you are preparing
by simply dragging and dropping them into the document. 

Templates 
A document template can be set up and applied to any document that is printed to the Zetadocs PDF program.
This allows documents to be sent in a standard format, with the correct stationery and attachments added for
a particular document type. This is useful in a variety of situations, especially if documents need to be sent
regularly by a group of people, for example invoices with a covering letter, and terms and conditions of sale. 

PDF Documents 
Just like normal attachments PDF documents can be saved as an attachment type within your Zetadocs PDF
window. however with PDF documents you can choose to combine the attachment into the document body or
to send the attachment as a separate document.
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What is the address book? 

The address book allows you to access your Outlook address book and search for recipients. This allows
contacts to be found quickly and easily. 
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What is the document explorer window?

The document explorer window shows you all the items that have been sent to the Zetadocs PDF application
for printing. This allows you see what items are waiting to be sent, and what components are included in each
document. This view allows you to manage the order of sections within your document and delete unwanted
sections.
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What is the reading pane?

The reading pane shows you a preview of the page of your spooled document that you have currently
selected. This allows you to  check any stationery you have added and ensure the document is ready to be
sent. 
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What is the batch preview pane?

Note: This is only available if you have a licence for automation

The batch preview pane is visible when you click on a batch in the document explorer window. It allows you to
quickly preview all the documents in the batch, and information about individual document, like:

Document - This is the personalized Zetadocs document, which can consist of several documents merged
together to form one document. It can have stationery and templates applied to it.
Name - This is the name of the person to whom you are sending the document
Organization - This is the company name of the recipient
Address - This specifies how the document is being sent, for example only email or only fax or both email and
fax. 

You can edit the individual documents on the list by clicking in the particular cell, or right-click on the
document and select Edit. For example you can rename a document, change the recipient's name, or add the
Recipient's Organization.

This also applies to the Address. 

To edit the address: 

Step 1: Click in the cell you wish to edit under the heading Address. This displays the Address dialog box:
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Step 2: Modify the email address accordingly or you can also for example, cc another recipient, or select
printer as a delivery method by clicking on More in the Address dialog box.
Step 3: Click OK to accept the changes.
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What is the thumbnail view? 

The thumbnail view allows you to see an overview of your spooled document. This allows you to:
· Navigate to particular pages within a spooled document.
· Change the  page order within a document section.
· Change the order of document sections.
· Delete pages.  
· Add stationery to individual pages 
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What is metadata? 

Metadata is data that provides information about your document.
 
When you send a PDF document, a metadata file is created, this file will allow your archive to be searchable.

This metadata file is created in the same folder that the PDF file is saved. The metadata file is an XML file with
extension “zdx” and the same name as the PDF file. The following metadata will be included in the file:

- Document Name
- Date and Time
- User Name
- Document Classification type
- Recipients
- Email Subject
- Email Body

If the Save Metadata as CSV option is selected, a CSV as well as an XML file will be written. This metadata
file will have the extension csv and the same name as the PDF file. 

Note: the CSV file will not use “” to delineate fields.



175

© 2008 Equisys plc.  All rights reserved.  All third-party trademarks are acknowledged

What is archiving? 

Archiving is a way of storing your sent PDF documents, allowing you to view your documents in the future,
resend your documents or add them to a new document.

PDF Archive File
When archiving is switched on, a copy of the PDF file will automatically be placed in the archive folder when
you select send from the client (or do the equivalent with embedded addressing commands). 

The PDF file will normally be given the same name as the PDF file attached to the email. (In the event of the
filename not being unique the following convention will be adopted: 

<original filename>(n).pdf 

where n increments to the next available  unique number.

For example:

Quote.pdf,  Quote(1).pdf, Quote(2).pdf …)

However if you wish to archive a file with a set name, you can specify this using the Output file embedded
command.

Note: if you choose to preview the email, the file will be archived, regardless of whether the email gets sent.

Related Topics 
How to resend a sent PDF
How to set up the Zetadocs Archive using the configuration program
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What are document classes? 

When documents are archived into a 3rd party system it is often useful to provide a classification for the
document for example: in the business area Accounts Payable, Invoice and Statement are examples of
document types. To support integration with this type of 3rd party system, Zetadocs PDF supports the use of
document types. 

Document types can be set using an embedded addressing command: 

%%[DocType: <document type>]

Where document type is any alphanumeric string (excluding the characters \, /, * or ?).

If a document type has been set by embedded addressing and the Archive To option is set to Single Folder
the following occurs on archiving:
· The PDF and metadata file will be archived to \<archive folder root>\<document type>\
· If the <document type> subfolder does not exist it will be created.

If a document does not have a type set, the file is archived in the root archive folder.
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What is Scanning? 

Scanning allows you to take paper documents, and using a piece of hardware (an optical scanner), convert
these documents to an electronic format.

This allows you to include these documents in your PDF files.
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Combining Zetadocs documents

Documents appearing in the Zetadocs Document Explorer window, can be combined using the Combine
Zetadocs documents command to create a single document.  
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Combining files

Any file, such as a Word document or Excel spreadsheet can be combined to any number of other files to
create a single document within Zetadocs using the Combine files command.  
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What configuration options are there? 

The configuration options menu is divided into the following sections:
· General settings  
· Fonts
· PDF security settings
· Licensing
· ACT!
· Diagnostics
· Scanning
· User information
· Bates numbering
· Automation (only available if you have a licence for automation)
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General settings 

Document Explorer Settings

Confirm file deletion
Should this tick box be selected, every time a file is deleted, the Zetadocs PDF program will not delete files
when requested to do so without double checking that this is the correct action to take.

Delete document after send
Should this tick box be selected, documents will be automatically deleted from the Zetadocs PDF application
once the send button has been used. 

Preview document before sending
When you ask for a document to be sent from Zetadocs, this option will allow you to preview the resulting
email and PDF attachment before it is sent.

Email Integration
Allows you to configure settings for your mail server, if you are using an SMTP mail server or Lotus Domino
mail server. 

PDF file options
Allows users to configure PDF file options settings, with the options to either use a smaller file size, or produce
better quality image but with a larger pdf output size.

User information 
The only field on this screen is User name/ department.  This is designed to allow you to set your Zetafax
Username.

Related Topics 
Change the document explorer settings
Configure email integration settings
Configure PDF settings
Change the user settings
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 ACT! 

You can use the ACT! options tab to configure ACT! database connections. An ACT! database connection
consists of a database filename (.PAD file), username, and password. A name is automatically assigned to an
ACT! database connection – this is taken from your company name (stored in "My Record" in the ACT!
database).

Note: Please ensure you have a "Company" name set on the "My Record" contact. This is not required for Act
but it is required for Zetadocs PDF.

Zetadocs PDF supports multiple ACT! databases, therefore you can add multiple databases at different
locations, using different usernames and passwords. Note that Zetadocs PDF cannot use more than one
database which has the same company name (from "My Record").

Note: If this dialog is disabled, then Zetadocs PDF did not detect an ACT! 7 or ACT! 8 installation on your
system.

Add – Click on the Add button to add an ACT! database connection.

Edit – Click on the Edit button to change an ACT! database connection. You can change the database filename
or location, username and password. You will need to update the connection if your company name has been
changed in the database.

Remove – Removes an ACT! database from the list.

Related Topics
Act Database Settings
Act Embedded Commands



183

© 2008 Equisys plc.  All rights reserved.  All third-party trademarks are acknowledged

Fonts 

This tab shows you which fonts are currently embedded into your PDF and which are excluded from your
document meaning they will only display properly if the font is present on the computer viewing the PDF.

Note: Some TrueType fonts are protected from embedding (sometimes for copyright reasons), and will not be
embedded in the PDF even though they have been marked for embedding. In this case the user opening the
PDF document should have the protected font installed on their computer in order to view the PDF correctly.
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Diagnostics 

Zetadocs PDF records a log of actions and issues which can be useful when troubleshooting a problem with
Technical Support. The log is written to file and to the Windows Application Event Log.

The logfile is written to the Zetadocs PDF directory which is usually located at:

c:\Documents and Settings\<username>\Local Settings\Application Data\Equisys\Zetadocs PDF\Zetadocs PDF.log. 

This log is in plain text format.

The Application Event Log is viewable using the Windows 'Event Viewer' tool.

Log to log file
Zetadocs PDF logs all actions and issues to the Zetadocs PDF.log file by default. You can turn off file logging to
improve performance if required.

Log to Application Event Log
Zetadocs PDF logs to the Application Event Log by default. Debug level messages are never written to the
event log. You can turn off event log logging to improve performance.

Log Level
Decides the detail of information that is logged. 

There are four levels of information that can be stored by Zetadocs PDF:

· Error level messages – are logged when a critical error occurs
· Warning level messages – are logged when a non-fatal error has occurred and the software can continue
· Informational level messages – are logged to indicate information about high-level actions
· Debug level messages – are low-level messages concerning the execution of software which may be

helpful to a developer

When you set the 'Log Level' the following information will be stored:

Level Information stored
Debug Log debug, informational, warning, and error

messages
Informational Log informational, warning and error messages

Warning Log warning and error messages

Error Log error messages only.

The default setting is Warning which captures basic troubleshooting information. While troubleshooting an
issue with Technical Support you may be asked to lower the level to Debug and to recreate the problem in
order to provide more detailed logging information.

OK
There is no need to restart Zetadocs PDF after changing the diagnostic settings – these are applied
immediately when you click OK.
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Licensing

The licensing window allows you to set where Zetadocs PDF should search for the configuration options that
your Administrator has set up.  By default, this will search the Active Directory for this information.  If no
Zetadocs PDF information is present in the Active directory, you can specify another location, or run Zetadocs
PDF in evaluation mode which will allow you to use all the features of the Software for 28 days. 
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PDF security 

The PDF security tab allows you to specify whether you wish to use security settings on your PDF. 

Open password
This option locks your document, so that only people who know the password may open the document and
read it.

To set a password simply tick the 'Require a password to open the document' check box and enter your
desired password  in the Document open password text box. 

Permissions:
The following options allow you to change the security settings of your PDF restricting different types of
activity. 

PDF printing
If this set to not allowed, documents can be viewed on the desktop, but no printed copies can be made. 

PDF modification:
If this is set to allowed, the PDF can be modified by a recipient using a PDF editor. 

PDF content copying:
If this is set to allowed, text within your created PDF can be highlighted and copied into other documents by
the recipient of your message. 

Adding/editing of notes:
If this is set to allowed, the recipient can add and edit notes within your PDF file if they have suitable software
installed on their machine. 

Permissions password 
By providing a password to unlock these features, you can control the level of access given to the PDF
document, if this is left blank, all options are permanently locked.
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Scanning

The scanning tab allows you to specify the default scanner to be used by Zetadocs PDF.  This scanner will then
be automatically selected . 

In addition you can set up your scanner so that it always uses the default scanning options allowing you to
automatically scan into Zetadocs PDF using the scan button.
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User information 

The only field on this screen is User name/ department.  This is designed to allow you to set your Zetafax
Username.
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Bates numbering 

Each page sent using the Zetadocs client can be automatically assigned a page number or stamp which can
appear in a pre-defined location on the page. Often referred to as automatic Electronic Bates numbering, this
technique is commonly used in the legal profession to assign a unique ID to each page to simplify retrieval.  

To enable Bates numbering, check the checkbox entitled ‘Use Bates Numbering’.   

This will allow you to configure the options, such as a fixed prefix, the start number, and a typeface and the
position where the stamp should be applied on each page.  

The Zetadocs client keeps a record of the last used Bates number, which increments for each page submitted,
ensuring that each page sent using the Zetadocs client is allocated a unique number.

Related Topics 
What are Bates Numbers 
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Automation 

Note: Automation is only available if you have purchased an automation licence.

The automation settings tab allow you to set default Batch submission options.

Batch submission 
Batch submission options allow you to delete a batch after sending it, preview a batch before sending, be
shown info messages on startup and shutdown, and view emails before sending.
 

Related Topics 
How do I change the automation settings?
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What is the Zetadocs Word Addin?

Installed as part of the main Zetadocs PDF install process, the Zetadocs Word Addin allows you to convert
documents from within Word, allowing them to be sent out as faxes or PDF attachments to email messages.
 
 The Zetadocs Word Addin consists of:
· Buttons and menu options that allow you to convert your documents to PDF.
· Embedded commands - allowing you to automate document creation and sending.
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What is the Zetadocs Excel Addin?

Installed as part of the main Zetadocs PDF install process, the Zetadocs Excel Addin allows you to convert
worksheets from within Excel, allowing them to be sent out as faxes or PDF attachments to email messages.
 
The Zetadocs Excel Addin consists of:
· Buttons and menu options that allow you to convert your documents to PDF.
· Embedded commands - allowing you to automate document creation and sending.
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What is the Zetadocs Outlook Addin?

Installed as part of the main Zetadocs PDF install process, the Zetadocs Outlook Addin uses the core
functions of Zetadocs PDF to allow you to quickly convert Office attachments to PDF.
 
Using the Zetadocs Outlook Addin gives you the option to convert your attachments into a single PDF or into
individual PDFs, and also to compress your attachments into a zip file.
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